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Chapter 1: Introduction To XTrackCAD 

XTrackCAD is a CAD (computer-aided design) program for designing Model Railroad layouts. 

XTrackCAD supports any scale, has libraries of popular brands of turnouts and sectional track (plus 

you add your own easily), can automatically use spiral transition curves when joining track and has 

extensive on-line help and demonstrations. XTrackCAD lets you manipulate track much like you 

would with actual flex-track to modify, extend and join tracks and turnouts. Additional features 

include tunnels, 'post-it' notes, on-screen ruler, parts list, 99 drawing layers, undo/redo commands, 

bench-work, 'Print to Bitmap', elevations, train simulation and car inventory.  

Using it, you can  

 Design layouts in any scale and gauge,  

 Use predefined libraries for many popular brands of turnouts to help you get started easily,  

 Add your own favorite components,  

 Manipulate track much like you would with actual flex-track to modify, extend and join tracks 

and turnouts,  

 Automatically generated Spiral transition curves (easements) whenever the track radius 

changes.  

 Test your design by running trains, including picking them up and moving them with the 

mouse.  

 Print the design in a scale of your choice. When printed in 1:1 scale the printout can be used as 

a template for laying the track to build your dream layout.  

New users should run the demonstrations (via the Help>Demos menu) to get an overview of the many 

features of the program. A number of example layout designs are also available.  

Be sure to visit the project web page for latest news and updates: XTrackCAD Fork Website  

 

 

 

 

http://www.xtrkcad.org/


1.1 Why Choose XTrackCAD 

Why Choose XTrackCAD  

Easy to use  

As much as possible, XTrackCAD is designed to operate the same as pencil and paper: create tracks by 

simply dragging the mouse, place turnouts anywhere on existing tracks, use circles for initial design 

and create stall tracks by drawing from the turntable.  

You don't have to be an expert CAD user to make the most of XTrackCAD. You don't specify line 

lengths or angles, just draw.  

XTrackCAD deals with tracks as tracks, not line segments. Tracks are connected to each other and can 

be drawn showing endpoints of turnouts and other components. As you zoom in, both rails are drawn.  

On-line demonstrations show the actual operation of many of the program's features. Extensive help is 

available for all commands and operations.  

Packed with features  

XTrackCAD is designed from the ground up to be a complete tool for Model Railroad layout design.  

Train Simulation and Car Inventory  

Any number of Cars and Locomotives can be placed on your layout to check clearances, siding 

capacities and track layout. Trains can be animated to simulate operations and switching on 

your layout. But be careful you don't crash!  

The Car Inventory dialog records your cars and locomotives.  

Track Manipulation  

Track segments can be lengthened or shortened by simple click and drag. Tangents to a curve 

are created by dragging away from the curve. Tracks are extended by dragging from an 

Endpoint, creating new straight or curved segments.  

Track circles are especially handy for determining overall designs and seeing what will fit in a 

given area.  

The Parallel command easily creates new straight or curved tracks, laying out yards and sidings 

in a few easy steps.  

The Join command links any two tracks (straight, curved, Turnouts or Turntables) with 

accurate aligned connecting track segments. The connected tracks are trimmed or extended as 

required.  

The Helix Track command computes the number of turns, radius, grade and vertical separation 

to based on your criteria.  

Turnout Select and Placement  

The Turnout Hot Bar contains a scrolling list of Turnouts, Sectional Tracks and Structures 

available in the current Scale. Simply click on one and drag it onto the layout.  

As Turnouts are dragged over existing tracks they are automatically aligned. XTrackCAD 

searches for any other tracks that align with each of the Turnout's Endpoints, and shows you 



the number of connections that will be made and the maximum offset as you position the 

Turnout. Just adjust the Turnout's position to minimize the offset to ensure the best fit.  

When a turnout is placed, each Endpoint is examined to see if it aligned to an existing track. If 

so, the track is split to create a perfect connection to the turnout. Placing Turnouts is a 'snap'.  

Layers  

Layers are an important feature for designing layouts of any complexity. Use one layer for the 

main-line and others for staging tracks, Bench-work or scenery. Multilevel designs can have 

groups of layers for each level.  

XTrackCAD allows up to 99 layers and the first 20 layers can have their own button to control 

visibility. Each layer can have a name which is displayed as the balloon help for the layer 

button.  

Tracks and other objects can be colored according to which layer they are in. Also, each layer 

can be frozen to prevent accidental changes to parts of the layout that are finalized.  

Elevations and Profile  

Elevations are one of the most powerful features of XTrackCAD.  

Traditional layout designs (such as published in magazines) show elevations at selected spots 

on the layout. They may also show grades between elevations.  

XTrackCAD lets you define the elevation of any Endpoint on the layout. You can also have 

XTrackCAD automatically compute the elevation and grade between defined elevation points. 

You can define the elevation at the bottom and top of a sloped track, then have XTrackCAD 

compute the elevation at each riser position between.  

Once you have defined a few elevations, you can display the Elevation Profile for the layout 

along a path of connected track segments. The Profile display shows the length of the track, the 

elevation of each defined elevation point and the grades between them. You can even adjust 

the elevations directly on the Profile display.  

Easements (Spiral Transition Curves)  

Easements are special sections of gradually curving track used to connect straight and curved 

tracks (or two curved tracks). Easements reduce the effects of sudden changes in track curves 

which can cause derailments. They also look great!  

XTrackCAD can use Easements anytime the radius of the track changes. The Modify and Join 

commands will automatically insert Easement Track segments whenever needed. Each 

Easement is computed based on the radius of the neighboring tracks. You don't even have to 

think about it!  

Flexible and Powerful Printing  

Printing is an important part of a layout design program, and XTrackCAD has a flexible Print 

command to get your design onto the layout.  

Printing is used for many purposes:  

 A snapshot of the whole layout.  

 Detailed closeups to examine areas of complicated track work.  

 Full 1:1 for direct transfer to the layout.  

The Print command lets you scale the printout from a one page overall view (with the handy 

Snap-Shot button) right up to full size 1:1.  

Multiple page printouts are easy to do. A gird representing each page is drawn over the layout 

and you can click on the pages you want to print. The gird can be moved and rotated to any 



position so the orientation of the printout matches your layout. Pages can be printed in Portrait 

or Landscape format.  

At 1:1, registration marks can be printed every 3" (or 10cm) to help align different sets of 

printouts. Also, the roadbed outline can be drawn at a user-specified width to assist cutting the 

roadbed from sheet material.  

Turnout and Structure Creation  

XTrackCAD comes with Turnout, Sectional Track and Structure Parameter Files for many 

brands of tracks and accessories. However, your brand may not supplied. The Turnout 

Designer dialogs and the Group command make it easy to add your own custom definitions.  

The Turnout Editor has separate screens for designing Turnouts (Regular, Curved, Wye and 3-

way), Crossings, Slip-switch, Crossovers and Sectional Track. In each dialog a few 

measurements are required to create a new definition. Full size printouts can be made directly 

from the dialog to check your design.  

The Group command can create Structure definitions from selected tracks, lines and shapes. 

You can make structures as simple as a rectangle or highly detailed. You can also modify 

existing designs to add details or make adjustments.  

Lines, Shapes, Table Edges, Text and Notes  

Layout designs are more than track!  

The XTrackCAD Draw command is used to draw lines (straight, curved and circles) and shapes 

(filled boxes, circles and polygons). These can be different colors and lines can have different 

widths. These are useful for drawing scenic features (rivers, bridges, mountains).  

You can add Bench-work and dimension lines too.  

Special types of lines are drawn by the Table Edge command are used to represent the 

boundary at the edge of the layout.  

Text can be drawn on the layout too.  

Notes can be attached to particular spots on the layout. When selected they can display special 

information about that part of the layout, such as prototype features, construction details or 

operation notes.  

Parts and Price Lists  

The Parts List command generates a list of the number of the different types of Turnouts, 

Sectional Track and Structures selected on the layout. You can select everything or just the 

areas you are working on. As well, the total length of flex-track (for each track scale/gauge 

used on the layout) is listed.  

You can enter the price of each type of Turnout, Sectional Track and Structure, plus the length 

and price of flex-track. XTrackCAD will compute the price of each types and the grand total. 

The total number of flex-track sections is also listed.  

Support for Sectional Track  

Numerous Sectional Track Parameter Files are included with XTrackCAD (Atlas, Marklin, 

Peco, ...). The Hot Bar allows easy selection.  

The automatic alignment feature of Turnout and Sectional Track placements makes track 

pieces just 'snap' together.  

The Connect Track command adjusts Sectional Track to smooth out the slight gaps that can 

arise when working with Sectional Track.  

Refer to Section 1.2 and Section 1.3 for a listing of XTrackCAD features.  

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/keyFeatures.html#keyFeatures
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/addFeatures.html#addFeatures


1.2 Key XTrackCAD Features 

 Annotate with text and notes  

 Automatic easement calculation  

 Create Custom Designed Turnouts and Structures  

 Create parallel straight and curved tracks  

 Delete objects  

 Describe objects  

 Draw lines, arcs and filled shapes (for showing river edges etc.)  

 Draw table edges, Bench-work and dimension lines  

 Elevations, grades and profiles  

 Extend (or shrink) a segment by dragging its Endpoint  

 Extend a segment with a curve (or straight)  

 Generate parts list for all or selected areas of the layout  

 Hand-laid Turnouts  

 Helix track  

 Hot Bar for Turnout and Structure selection  

 Join any two tracks  

 Move and rotate any group of objects  

 Ninety-nine drawing Layers  

 On-line demonstrations, extensive help, tips and error message explanations  

 On-screen ruler for measurements  

 Panning via a map window  

 Price lists  



 Printing in any scale (up to 1:1) at any position and angle  

 Straight and curved flex-track segments  

 Supports any scale  

 Track circles and tangent tracks  

 Train Simulation  

 Tunnels (hidden tracks)  

 Turnouts, crossings (and sectional track such as Atlas Snap-track)  

 Turntables (user defined diameter)  

 Undo the last ten commands  

 Zoom in and zoom out of the drawing area  

 

 

 

 

 

 

 

 

 



1.3 Additional XTrackCAD Features 

XTrackCAD has many other carefully selected features:  

 Sections of track can be hidden, which can be drawn as dashed lines, or completely hidden. A 

Tunnel Portal is drawn when a hidden track connects with normal track.  

 Drawing Turntable stall tracks is easy, just drag from the Turntable with the Modify command. 

The minimum angle between tracks can be set to ensure accurate, evenly spaced tracks.  

 Connections to non-visible layers are marked to an arrow head to show you the track continues 

on another layer.  

 The Group command can be used to decorate custom designed Turnouts and Sectional Track 

with details to indicate switch machines, ground throws and power connections.  

 Custom designed Turnouts can be modified, renamed or deleted with the Custom Management 

dialog.  

 Flex-track connected to Turnouts is labeled with the total length to aid cutting flex-track to 

length.  

 An on-screen ruler can be user to measure arbitrary distances.  

 At 1:1 drawing (and printing) scale the track center line is drawn to make it easy to position 

roadbed and track.  

 The balloon help for the Undo and Redo buttons shows the command that would be Undone or 

Redone.  

 The Snap Grid can positioned at any origin and any angle. It can also be printed to help when 

transferring coordinates to the layout.  

 The Map window is used to position the Main window on the layout. It can also be used to 

change the drawing scale.  

 You can rescale and flip objects, trim turnouts and create block gaps.  

 

 

 

 



 1.4 About This Manual 
 Typographic Conventions  
 Throughout this manual the following typographic conventions are used to make finding 

information easier:  

 Bold - Shows menu, file or dialog item titles.  

 Mono-spaced - Shows commands or text entries by user. On entry fields the spelling given has 

to be followed exactly.  

 Italic - Marks a new expression, usually followed by a short description  

 Capital Key - Usually used in a sequence of key strokes or in combination with Shift, Alt or 

Ctrl key.  

 Key+Key - Combination of keys, e.g., Ctrl+S  

 Key, Key, Key - Sequence of key strokes, e.g., Alt, F, S  

 Selection>Selection - Sequence of selections from menu, e.g., File>Save  

 

 

 

 

 

 

 

 

 

 

 



1.5 Installation 

XTrackCAD is designed to operate under Linux or MS Windows. Information within this section of 

the manual pertains to installation of the application in either of these environments.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



1.5.1 Microsoft Windows Installation 

XTrackCAD is shipped as a self-installing self-expanding program (executable).  

1. Using Windows Explorer, locate the directory in which you downloaded or copied your new 

version of XTrackCAD.  

2. Start the installation program by double clicking on the xtrkcad-setup-4.0.3a.exe file icon.  

3. Follow the steps in the installation program.  

4. The installation lets you define the directory in which XTrackCAD is installed. The directory is 

created automatically if it doesn't already exist.  

5. A program folder named XTrkCad4 will be created during the installation process. The folder 

contains the program, documentation, parameter and example files.  

 

 

 

 

 

 

 

 

 

 

 



1.5.2 Linux Installation 

XTrackCAD for LINUX is shipped as a RPM file and a self-extracting archive (executable).  

1. Installing from an RPM file  

After downloading the rpm file, do  
rpm -ihv xtrkcad-setup-4.0.3a.i386.rpm  

Replace -ihv with -Uhv to upgrade an existing XTrackCAD installation.  

2. Installing from the self-extracting archive.  

After downloading open a command line then  
./xtrkcad-setup-4.0.3a.i386.sh --prefix=/usr/local --exclude-subdir  

This will install the executable in /usr/local/bin. A directory named xtrkcad will be created in 

/usr/local/share and all files will be unpacked into it.  

If you install XTrackCAD into another directory, set the XTRKCADLIB environment variable to point to 

that directory.  

 

 

 

 

 

 

 

 

 



1.6 Quick Tour 

 

When XTrackCAD starts, it displays the Main (Section 3.1) and Map (Section 3.2.2) windows. The 

Map window is used to change the origin of the Main window when the entire layout cannot be 

displayed at one time.  

The Menu bar across the top of the Main window contains standard Windows menus. Some of these 

are particularly useful to the new user:  

 The File>Exit menu exits XTrackCAD. You can also exit by selecting the System menu in the 

upper left corner of the Window.  

 The File>Open menu opens existing layout files. When first installed, the default directory 

contains some example programs you can look at.  

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/mainW.html#mainW
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdMap.html#cmdMap


 The Help menu can be used to read the XTrackCAD Help file. Also, the Help>Demos menu 

selects a number of demonstrations which illustrate various features of XTrackCAD.  

 The Options>Layout menu specifies the working scale and overall room size.  

 The Options>Preferences menu specifies some less frequently changed items. You can use 

this menu to choose Metric units (Section 2.10.7).  

 

 

 

 

 

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdPref.html#cmdPref


1.7 Performance Issues 

This section lists some things that can improve the performance of XTrackCAD.  

 To speed up initialization, remove unused parameter files (See Parameter Files dialog - 

Section 2.5.5).  

 During moves and rotates, draw tracks Simply or as Endpoints (See Command Options 

dialog - Section 2.10.2). Also Zoom In (Section 2.12) to reduce the number of tracks that are 

being displayed.  

 If you have to move a lot of track a large distance, create a temporary track at the destination 

and use the Join (Section 2.2.6) command to move the selected track to join with the 

temporary track. Then remove the temporary track.  

 Close the Map window if you don't need it to move about the layout. The Window (Section 

2.13) menu can be used reopen the Map window.  

 On the Display dialog (Section 2.10.3) turn off drawing Endpoints, decrease the Two Rail 

Scale, increase Min Grid Spacing, set Draw Ties to None and turn off Live Map.  

 

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdPrmfile.html#cmdPrmfile
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdCmdopt.html#cmdCmdopt
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/viewM.html#viewM
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdJoin.html#cmdJoin
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/windowM.html#windowM
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/windowM.html#windowM
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdDisplay.html#cmdDisplay


1.8 Files and Directories 

Information within this section of the manual identifies installation directory names, file names and 

directory and file locations.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



1.8.1 Directories Overview 

XTrackCAD uses two directories on your system:  

 The XTrackCAD Install directory, which contains the data and parameter files used by 

XTrackCAD.  

 The XTrackCAD Working directory, which contains configuration and Check Point files.  

On MS-Windows the Install and Working directories are set when you install XTrackCAD.  

On Linux the Install directory is usually /usr/local/lib/xtrkcad/, but you can change this by 

defining the XTRKCADLIB environment variable before starting XTrackCAD. The working directory is 

{HOME}/.xtrkcad/.  

Layout files (*.xtc) and export (Section 2.5.1) files (*.xti) can be saved anywhere you wish, as 

specified in the Save File and Open File dialogs.  

Example layouts can be found in the example directory under the XTrackCAD install directory.  

 

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdExport.html#cmdExport


1.8.2 Install Directory 

 xtrkcad.xtq is the main parameter file which contains definitions for each scale. It also 

includes turnout definitions for the demos and lists the playback (.xtr) files for the demos.  

 params directory contains *.xtp files which are the XTrackCAD Library parameter files. 

These files (atlasn.xtp, pecon55.xtp, ...) contain definitions for turnouts, sectional track 

pieces and structures. These files to be used are selected in the Parameter Files (Section 2.5.5) 

dialog.  

 xtrkcad.chm (on MS-Windows) or xtrkcad.help (on Linux) is the XTrackCAD help file.  

 xtrkcad.exe (MS-Windows) or xtrkcad (Linux) is the XTrackCAD program.  

 xtrkcad.tip contains the Tip of the Day information accessible from the Help menu or 

shown during startup.  

 xtrkcad.upd contains the list of parameter files supplied with XTrackCAD  

 xtrkcad0.ini specifies the location of the XTrackCAD working directory (MS-Windows 

only).  

 demos directory contains *.xtr which are the XTrackCAD demonstration files which can be 

run via the Help>Demos menu item.  

 examples directory contain some example .xtc files  

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdPrmfile.html#cmdPrmfile


1.8.3 Working Directory 

 xtrkcad.ckp are the check-point files created periodically while running XTrackCAD. If your 

system XTrackCAD hangs or crashes you get the choice of loading the checkpoint file and so 

recover (most of) your work by saving it to your current layout file.  

The check-point frequency is set by the Check Point field found in the Preferences dialog 

(Options>Preferences).  

 The xtrkcad.cus file contains parameter information. This is mostly information created by 

the Turnout Designer dialogs (Section 2.9.8) and Group (Section 2.9.3) command. You can 

use the Edit>Custom Management dialog to manipulate these parameters.  

 The xtrkcad.ini (on MS-Windows) or the xtrkcad.rc (on Linux) file contains various 

parameter settings from each use of XTrackCAD. Most changes you make (such as scale, room 

size, window position) are saved in this file for the next time you use XTrackCAD.  

 

 

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdTurnoutNew.html#cmdTurnoutNew
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdGroup.html#cmdGroup


1.9 Removing XTrackCAD 

Remove XTrackCAD by deleting the XTrackCAD Install directory, deleting any xtrkcad.* files from 

the Working directory, and deleting any *.xtc and *.xti files.  

On MS-Windows, you can also use the Uninstall icon in the XTrackCAD program group.  

 

 

 

 

 

 

 

 

 

 

 

 

 



1.10 Bugs and Enhancements 

This section of the manual describes how and where to report a bug or seek an enhancement.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



1.10.1 Reporting Bugs 

If you encounter an unreported bug please submit detail regarding such to the Bug Tracker located at 

the XTrackCAD Fork Project Site.  

Be sure to provide the three basic elements of a bug report: What you were doing at the time the 

bug occurred, what you expected to happen and what actually happened. This detail will help 

developers replicate the error, find and correct the offending code.  

A Sample Bug Report Follows;  
After completing installation of XTrackCAD on a Dell Dimension PC with 128 MB of memory 

running Windows ME, the following error occurred when attempting to edit a Text Label;  
Notice: allocateButt: Can't find 13. Do you want to save the layout?  
Selecting either "Yes" or "No" results in a Windows error and XTrackCAD closes.  

The error can be replicated by opening the file named cascade.xtc. Set the magnification at 4:1. 

Attempting to move the text label named "Granville Island" located at the approximate grid 

coordinates of x=8", y=4' 5". Selecting the label causes the error to occur.  

The error is repeatable with other files contain text labels.  

Always search the bug database first. Advice so good, we'll repeat it twice. Always search the bug 

database first. The odds are good that if you've found a problem, someone else found it too. If you 

spend a few minutes of your time making sure that you're not filing a duplicate bug, that's a few more 

minutes someone can spend helping to fix that bug rather than sorting out duplicate bug reports.  

If you don't understand an error message, ask for help. Don't report an error message you don't 

understand as a bug. There are a lot of places you can ask for help in understanding what is going on 

before you can claim that an error message you do not understand is a bug. (Once you've understood 

the error message and have a good suggestion for a way to make the error message clearer, you might 

consider reporting it as a XTrackCAD Feature Request).  

Be brief, but don't leave any important details out. This is a fine line to walk. But there are some 

general guidelines:  

Remember the three basics: what you were doing, what you expected to happen, and what happened.  

If you can recreate the problem the Macro>Record command can be used to record what happened. 

Try to isolate the problem by creating a minimal layout and recording as few commands as possible.  

Don't report bugs about old versions. Every time a new version of XTrackCAD is released, many 

enhancements are added and known bugs are fixed. If you're using a version of XTrackCAD that's 

more than two revisions older than the latest version, you should upgrade to the latest version to make 

sure the bug you are experiencing still exists. (It's not a bad idea to upgrade even if your version is 

only a version behind the most current one.)  

http://sourceforge.net/tracker/?group_id=151737&atid=781978
http://sourceforge.net/tracker/?group_id=151737&atid=781981


Only report one problem in each bug report. If you encounter two or more bugs that don't appear to 

be related create a separate bug report for each one. This makes the task of managing work 

assignments easier and may result in a quicker fix for the problem.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



1.10.2 Enhancement Requests 

Suggestions for improvements are encouraged and welcome. Submit your suggestion to the 

XTrackCAD Feature Tracker located at the XTrackCAD Fork Project Site or the XTrackCAD Wikka 

Wish List located at the XTrackCAD Wiki: WishList.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://sourceforge.net/tracker/?group_id=151737&atid=781981
http://www.xtrkcad.org/Wikka/WishList


Chapter 2: Command Menus 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2.1 Add Menu 

 

The Add Menu has all the actions related to adding track pieces to the layout.  

Circle Track - place a circle of track by selecting radius, tangent and or center (Section 2.1.1).  

Curved Track - lay curved track pieces using different modes for selecting start and endpoints 

and radius (Section 2.1.2).  

Hand-laid Turnout - lay a turnout in place on the layout.  

Helix - Add a helix.  

Parallel - create parallel track to existing flex-track, straight or curved.  

Straight Track - lay straight track pieces of arbitrary lengths  

Structure - Add a predefined structure to the layout.  

Turnout - select a turnout or a piece of fixed track and place on layout.  

Turntable - Place a turntable.  

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdCircle.html#cmdCircle
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdCurve.html#cmdCurve


2.1.1 Circle Track 

 

A circle track is a special form of a curved track that extends 360° and has no endpoints. The three 

methods (with their Shortcut keys) used to create a Circle Track are:  

 (Control-8) Use the Fixed Radius specified on the Circle Radius control displayed on 

the Status Bar (Section 3.1). Drag the Circle track into position.  

 (Control-9) Drag from tangent point (Edge) of the Circle track to the Center.  

 (Control-0) Drag from the Center of the Circle track to the edge.  

A drop down menu, which allows selection of the Circle Track creation method, is invoked from the 

down arrow button ( ) located on the right side the Circle track button. Dependent upon previous 

selection, the Circle Track button will look like or .  

 
Circle Track Button Menu  

If Snap Grid (Section 2.12.1) is enabled then circle centers will be constrained to the grid.  

Circle tracks are useful for fitting curves into corners and other tight places. They're also handy when 

establishing an initial layout and finding out "what will fit".  

You can join to and from circles, after which they become curved tracks.  

 
 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/mainW.html#mainW
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdGrid.html#cmdGrid


2.1.2 Curved Track 

 

Creating a curve is a two step operation. The four methods (with their Shortcut keys) used to create a 

Curved Track are:  

 (Control-4) Drag from one endpoint in the direction of the Curve at that point and release. 

Click and Drag to position the second endpoint.  

 (Control-5) Drag from one of the endpoints to the Center of the Curved track and release. 

Click and Drag to position the second endpoint.  

 (Control-6) Drag from the Center of the Curved track to one of the endpoints and release. 

Click and Drag to position the second endpoint.  

(Control-7) Drag from one endpoint to the other endpoint to form the Chord of the Curve 

and release. Click on the center of the track and Drag to form the Curve.  

A drop down menu, which allows selection of the Curved Track creation method, is invoked from the 

down arrow button ( ) located on the right side the Curved track button. Dependent upon 

previous selection, the Curved Track button will look like , , or .  

 

Curved Track Button Menu  

In all cases, two Red arrow heads will be drawn after the first step to indicate where you can Drag to 

complete the second step.  

A straight track will be created if the second endpoint is lined up with the first endpoint.  

If the Snap Grid (Section 2.12.1) is enabled then the endpoints will be constrained to the grid.  

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdGrid.html#cmdGrid


Optionally, the curve center point and radius can be displayed for the Curve. This is enabled by the 

Move Label (Section 2.2.9) command.  
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2.1.3 Hand-laid Turnouts 

 

Hand-laid turnouts are created by specifying 3 values:  

 Position of Frog  
 Angle of Frog (the frog number)  
 Position of Points  

First select the position for the Frog (Section B.2) on an existing track and then Drag away to specify 

the angle of the Frog. The angle in degrees and equivalent frog number is displayed on the status bar. 

When you release, the line indicating the angle jumps to one side of the track to show you the center 

line of the new leg of the turnout.  

Next Click and Drag to position the Points (Section B.2) for the turnout. As you Drag, tracks will be 

drawn showing the turnout. When you release the turnout is created.  

You cannot place the Frog or Points on a turnout, circle or helix. However, you can create overlapping 

Hand-laid Turnouts.  

There are constraints on where you can place the Points in relation to the Frog. You cannot place the 

Points too close the Frog. When placing Hand-laid Turnout on a curved track you may get unexpected 

results, especially when placing the Points a long way from the Frog. Try changing the Frog angle to 

get different results.  

Note: the drawing is an approximation to show the location of the Points and Frog. The piece of track 

considered (by XTrackCAD) to be a Hand-laid Turnout is a short section of track located at the Points 

and extending toward the Frogs. Other track segments are created between the Points and Frog and a 

short straight segment is drawn after the Frog. These other segments are independent of the turnout 

and can be removed or modified, although this is probably not a good idea.  
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2.1.4 Helix Track 

 

A helix track is used to change the elevation of track in a restricted space. A helix is drawn as a circle 

of track, but in 3 dimensions it would resemble a cork screw or the pattern of threads on a bolt.  

 

A helix is defined by the number of Turns and Radius.  

The helix dialog allows you to calculate these values based other parameters such as the Elevation 

Difference, Grade, Vertical Angular Separation. Angular Separation is the difference in degrees 

between tracks entering and exiting the helix. Changing any of these values effects the other values. 

For example, increasing the Radius decreases the Grade. Changing the number of Turns affects the 

Vertical Separation and either the Radius or Grade.  

In the case where different parameters could be affected (for instance changing Elevation Difference 

can affect Radius or Grade) the last parameter you changed will be preserved. If you set the Grade and 

then Elevation Difference then the Radius will be adjusted.  

Changing Vertical Separation affects Turns which must be an integer value (no fractions), and this in 

turn affects the Vertical Separation. When you set Vertical Separation you are specifying the 

minimum separation which is adjusted upwards to the actual value.  

Note: only the Radius and Turns are used when creating the helix. After joining the helix to other 

tracks, you will want to establish the heights of the endpoints at each end of the helix. You can use the 

Elevation (Section 2.2.4) command to do this.  

A helix is placed the same way as a Circle Track (Section 2.1.1) with the addition that you specify the 

number of turns as well the as the radius of the helix. Then the helix is dragged into position on the 

layout.  

You can join to a helix in the same way you join to a circle. However, once joined the helix is still 

drawn as a circle of track.  
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A label for the helix is drawn at it's the center. If the elevations are set (either by a Defined Elevation 

point or connecting to a Defined Elevation point) for the two ends of the helix then the label contains 

the computed grade and vertical separation between layers as well as the number of turns and total 

length. The label can be moved or turned off by the Move Label (Section 2.2.9) command.  
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2.1.5 Parallel Track 

 

You can create a new track parallel to any straight, curved or easement track.  

 

The Parallel Separation control (Visible in the Status Bar) displays the current separation between 

parallel tracks. This value can be changed before selecting a track. The value must be greater than 0.0.  

Select the track you want to parallel, and the new parallel track will appear beside it. You control 

which side the new track will be on by moving the cursor from one side to the other of the selected 

track.  

This is very useful for creating sidings and yards.  

You cannot create tracks parallel to turnouts or sectional track.  

It is possible to create tracks that abut (the endpoints are very close and aligned). These endpoints will 

be automatically connected.  

 

 

 

 

 

 

 

 



2.1.6 Straight Track 

 

Straight track is a created by selecting the first endpoint then dragging the cursor to the point where 

you want the second endpoint to be.  

If the Snap Grid (Section 2.12.1) is enabled then the endpoints will be constrained to the grid.  
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2.1.7 Structure 

 

The Structure command places diagrams of structures (buildings, bridges and other scenic elements) 

on the layout. The operation is similar to the Turnout (Section 2.1.8) command.  

 

When you select a structure from the list, its diagram is drawn in the diagram canvas. The dimensions 

are also listed on the dialog.  

The Structure Selection dialog will disappear while dragging on the layout if the Hide Check Box on 

the dialog is set. This is useful if you have a small screen.  

See the Hot Bar (Section 2.7) command for details on placing Structures on the layout.  
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Structures are placed on the layout in same way as turnouts except that there is no Active endpoint 

and structures do not align with existing tracks.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2.1.8 Turnouts 

 

Turnouts (and sectional track) are created by the Turnout command . When you select the turnout 

command, the Turnout Selection dialog is displayed which contains a list of available turnouts and 

sectional track for the current scale (Section 2.10.6) and a diagram of the selected turnout.  

You can use the Parameter File Dialog (Section 2.5.5) to control what turnouts are available.  

 

Select a turnout from the scrolling list. A picture of the selected turnout is drawn in the diagram 

canvas. You can pick the Active endpoint (Section B.2) by clicking on an endpoint in the diagram. 

The Active endpoint (Section B.2) is indicated by a highlighted square.  

The New button invokes the Turnout Designer (Section 2.9.8) dialog. This button displays a pop-up-

menu list of various types of turnouts and sectional track.  
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The Turnout Selection window will disappear while dragging on the layout if the Hide Check Box on 

the dialog is set. This is useful if you have a small screen.  

See the Hot Bar (Section 2.7) command for details on placing Turnouts on the layout.  
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2.1.9 Turntables 

 

Turntables of specified diameter are created with the Turntable command.  

 

The Turntable Diameter control (Visible in the Status Bar) displays the current diameter of the 

turntable. This value can be changed before dragging the turntable into position. The value must be 

greater than 0.0.  

The Modify command (Section 2.2.7) can be used to create turntable stall tracks. Select the turntable 

and drag the stall track to the proper angle and length. You can also connect to a turntable with the 

Join command (Section 2.2.6).  

The Turntable Angle control on the Preferences (Section 2.10.7) dialog controls how closely you can 

place tracks connected to a turntable. If you want to create stall tracks every 7.5°, set the Turntable 

Angle control to 7.5 and place the track as close to each other as allowed. XTrackCAD makes sure 

they will be separated by the correct angle.  

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdModify.html#cmdModify
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdJoin.html#cmdJoin
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdPref.html#cmdPref


2.2 Change Menu 

 

The Change Menu has all functions related to modifying objects that exist on the layout drawing.  

Change Scale - change model scale and / or gauge of layout design. (Section 2.2.1)  

Clear Elevations - remove elevation parameters from selected track(s).  

Connect Sectional Tracks - creates a connection between sectional track pieces by slightly moving the 

select piece(s) and the pieces they connect to.  

Elevation - define an elevation at specified track location (Section 2.2.4).  

Flip - turn selected object(s) over or around.  

Join - connect two separate pieces of track. This command can be used to move one of the pieces of 

track to the endpoint of the other or to create a connection by laying a stretch of flex-track.  

Modify - modify an existing track.  

Move - move selected object(s).  

Move Description - move the endpoint description of a track piece to another location.  

Profile - display the elevation profile of a definable stretch of track (Section 2.2.10).  

Properties - sets XTrackCAD into Describe mode. Whenever an object is clicked on while in this mode, 

the Properties dialog is opened. This dialog allows direct manipulation of settings such as the objects 

length, position or orientation.  
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Raise/Lower Elevations - raise or lower elevation of selected tracks.  

Rotate - rotate selected object(s).  

Recompute Elevations - performs a global re-computation of dynamic elevations. It should not be 

necessary to issue this command as elevations are recomputed as required.  

Select - sets XTrackCAD into Select mode. Whenever an object is clicked on while in this mode, this 

selection state of this object is reversed. If an object was unselected it becomes selected, and vice 

versa. To unselect all objects press the ESC key, use Deselect All from the Edit (Section 2.4) menu or 

Deselect All from the Pop-up menu (Section 3.4.1).  

Split Track - the Split Track command can be used in one of two ways;  

 split a section of flex-track into two connected pieces at the point where a Left-Click is invoked 
or;  

 disconnect turnouts or sectional track pieces at their point of connection.  
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2.2.1 Change Scale 

 

Change Scale is used to change the size and gauge of selected (Section 2.2.14) objects. The amount to 

resize can be specified  

 by the modeling scale, e.g., convert from HO to O scale  
 by the modeled gauge, e.g., convert from standard gauge to narrow gauge, or  
 by ratio (by 181.5%).  

If resizing by modeling scale then track dimensions, e.g., lengths and radii, will be changed as well. 

An option is available to disable the resizing of the selected objects.  
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2.2.2 Clear Elevations 

The Clear Elevations command is used to remove elevation points from selected track on the layout.  

Using the Select command, select the track that is to have its elevation settings cleared then select 

Change>Clear Elevations from the menu bar to clear elevations of selected track.  

 

 

 

 

 

 

 

 

 

 

 

 

 



2.2.3 Connect Sectional Tracks 

 

This command is used exclusively with Sectional Track.  

Occasionally pieces of sectional track do not line up exactly, especially when creating figure-8's or 

passing sidings. When laying out the actual track you can compensate for this by adjusting the 

individual tracks to provide a bit of slack. This command simulates that process.  

Click on the endpoint of each track you're trying to connect. Tracks will move slightly in an attempt to 

overcome the gap. If the gap is too large, the connection will fail. If this occurs, try using other track 

pieces in your layout.  

XTrackCAD adjusts the positions of tracks connected to the tracks up to a track with more than two 

connections. See the Demo for details.  

If one (or both) the selected tracks is an adjustable section (such as Kato's Adjustable Track #20-050) 

then the length of the track is changed to fill the gap.  

You can undo the effect of the Connect command by splitting (Section 2.2.15.1) the track to 

disconnect it then using the Shift+Left-Click Connect command on the unconnected endpoints to 

tighten connections between the tracks.  

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/splitDisconnect.html#splitDisconnect


2.2.4 Elevation 

 

The Elevation command changes the elevation of track endpoints. After opening this dialog, you can 

click on the respective endpoint to set its elevation properties. The endpoint on which you work is 

indicated with a big red dot.  

 

An endpoint can have one of several elevation types:  

 None - no elevation defined.  
 Defined - a defined elevation at a specified height.  
 Hidden - a defined elevation but not displayed on the layout.  
 Computed - height is based on height of closest neighbors.  
 Grade - grade is based on height of closest neighbors.  
 Ignored - endpoint is not considered in computations.  
 Station - assigns a name to the endpoint.  

Note: Only one of these attributes can be assigned to an endpoint. For example, an endpoint can not be 

defined as a Grade and a Station at the same time.  

When an endpoint is selected on the layout by Left-Click, it is highlighted by a large red dot and its 

elevation type and values are displayed in the dialog.  

Additionally, Defined Elevation endpoints are indicated on the layout by gold colored dots. Ignored 

Elevation endpoints are indicated by blue colored dots.  

Shift+Left-Click splits the track at the specified point and adds an elevation point.  

The grade at the specified endpoint is displayed next to the Grade radio button. For Defined 

Elevation endpoints, the grade on each side of the endpoint is displayed.  

Defined Elevation endpoints are used to specify fixed heights of track endpoints. Typically, this 

would be where a grade changes or where clearances must be maintained. Computed Elevations and 

Grade markers can place between Defined Elevation endpoints. These values are not entered directly 



but are computed dynamically based on Defined Elevations of connected tracks. This allows labeling 

of elevations at intermediate endpoints without having the enter specific values. Computed markers 

can also placed between a Defined Elevation point and the end of a track.  

Stations are used to provide information for the Profile (Section 2.2.10) command.  

All Elevation labels (including Grade and Station) are drawn on the layout in outlined boxes. These 

may be moved by the Move Description (Section 2.2.9) command. In addition, Grade labels have an 

arrow indicating the upwards direction.  

 

 

 

 

 

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdProfile.html#cmdProfile
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdMoveLabel.html#cmdMoveLabel


2.2.4.1 Computing Dynamic Elevations 

Elevations of Tracks are computed in following steps. The colors listed in each step are used as the 

background color of the Track Elevation Markers (if they are enabled (Section 2.10.3)).  

 The Shortest Paths between all Defined Elevations are computed. A Path stops at Ignored or Defined 
endpoints. The Elevation of any Turnouts on these Paths with more than two connections are 
computed as the average Elevation inversely weighted by distance along the tracks to the Defined 
Elevation points (Blue).  

 The Elevation of any other tracks on the Shortest Paths are computed based on the distance along the 
tracks from the Turnouts computed in the first step and/or the Defined Elevation points (Purple).  

 The Elevation of any remaining tracks is computed based on the average Elevation of the tracks found 
in the first two steps that they are (directly or indirectly) connected to, inversely weighted by 
geometric distance (Gold).  

 Any remaining tracks are not connected to a Defined Elevation and do not have an Elevation.  

The elevation computation is performed incrementally every time the layout is changed to keep all 

elevations in sync. The performance of the computation is affected by the placement of the Defined 

Elevation endpoints and the number of Paths between them. Place the Defined Elevations at points 

where tracks begin to branch (such as the throat of a yard or at the ends of a siding). Also, use Defined 

Elevations to break the layout into areas so recomputation has fewer tracks and Paths to deal with.  
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2.2.5 Flip 

 

This command turns selected objects over or around, effectively mirroring the object .  

1. Prior to invoking this command visualize how the selected object(s) will be flipped and determine 
where to draw a reference line that will act as an axis or anchor point for the flipped object(s).  

 

2. Invoked the Flip command then Left-Click on one end of the reference line visualized in the 
proceeding step. Holding the Left mouse button, Drag the cursor across the layout to form the line 
visualized earlier.  

 

3. Once a line of desired length and orientation appears, release the mouse button. The selected 
object(s) will then flip around the line as if it were a mirror.  

Since flipped objects are mirrored, turnout titles may be modified during the flip process. Right hand 

turnouts will become left hand turnouts and vice versa. Such is the case in this example.  

Certain turnouts, such as a Wye's, Three-Way or Crossings are symmetrical and thus titles for this type 

of objects are not changed. If a title change is necessary the currently loaded Parameter Files (Section 

2.5.5) are searched for a turnout that matches the flipped turnout. If a match is not found, the turnout's 

title is prefixed with Flipped. The Properties (Section 2.2.11) command be used to change the title of 

such turnouts.  
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2.2.6 Join 

 

The Join command is used to bring together and connect any two segments of track. During the join 

process, XTrackCAD ensures the connecting tracks are properly aligned.  

See Help>Demo (Section 2.6.1) for examples of how to join tracks.  

For detail about;  

Using curved flex-track to join track segments refer to Section 2.2.6.1.  

Using straight flex-track to join track segments refer to Section 2.2.6.2.  

Moving one segment of track to join with another refer to Section 2.2.6.3.  
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2.2.6.1 Using Curved Flex-Track 

This method of joining track may be used where tracks are joined with a 'simple curve', e.g. one which 

uses a curve in a single direction as opposed to using reverse curves (Section B.2).  

 

1. Start the join process by clicking on the Join button ( ).  

 

 

 

2. Left-Click the endpoint of one of the two tracks being joined. A red dot will appear as a reminder of 
which track has been selected.  
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3. Move the mouse pointer over the endpoint of the other track then Left-Click and hold the mouse 
button down. A track connecting the two endpoints will appear. If the track appears in black (and you 
are happy with the curve as its drawn), release the mouse button.  

 

4. If the track appears in red, it means XTrackCAD can't determine how to connect the first track with the 
second. If this occurs, while holding the left mouse button, drag the mouse back toward the first track 
until the connecting track appears in black. If the connecting track remains red, drag the mouse in the 
opposite direction until the connecting track turns black. Once the connecting track turns black, 
release the mouse button to finalize the Join command.  



 

Throughout the above, the exact shape of the curve can be adjust by dragging the mouse around while 

keeping the left mouse button held down.  

Sometimes, no matter where you drag the mouse, the curve stays red and the tracks cannot be 

connected. This means the resulting curve is tighter than the minimum track radius set in the 

Preferences dialog (Section 2.10.7). If desired, this setting can be adjusted from the Preferences 

dialog using the Options>Preferences menu selection to raise the dialog. If changing the minimum 

track radius is not a desired option then it will be necessary to relocate one of the tracks that you're 

attempting to join.  

You may also find that XTrackCAD will not create the connecting curve in the exact shape you want. 

If this happens it may be necessary to either move one of the end points or draw a partial curve (or 

straight) and try again.  

If enabled, Easements (Section 2.10.4) will be automatically generated between tracks of differing 

radii. When using easements, there is a minimum radius as specified in the Easement dialog. It's not 

possible to join tracks with less then this radius and the connecting track's radius must be greater than 

the minimum radius.  

If any errors occur while joining tracks (such as moving beyond the end of a track or using a curve 

with a radius smaller than the Easement radius), then the joint track will be drawn in Red (The default 

colour of Exception Track errors. See Section 2.10.1 for detail). This colouring serves as visual 

indication for a connecting track that doesn't meet minimum specified parameters (Section 2.10.7).  

Any tracks created during the Join command will have the following properties inherited from the first 

track: selected state, hidden state, scale, track gauge and Layer.  

A join can be made to or from a circle (Section 2.1.1) of track. Joining a track with a circle will cause 

the circle to be converted into a curved track.  

For detail about;  
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Using straight flex-track to join track segments refer to Section 2.2.6.2.  

Moving one segment of track to join with another refer to Section 2.2.6.3.  
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2.2.6.2 Using Straight Flex-Track 

This method of joining track may be used where the endpoints of the two tracks to be joined are on the 

same horizontal (X) or vertical (Y) axis.  

 

1. Start the join process by clicking on the Join button ( ).  

 

2. Left-Click the endpoint of one of the two tracks being joined. A red dot will appear as a reminder of 
which track has been selected.  

 

3. Move the mouse pointer over the endpoint of the other track then Left-Click. A track connecting the 
two endpoints will appear.  

When this command is used to join;  

 two flex-track endpoints, one long section of flex-track without joints will result.  
 two sectional track endpoints, a section of flex-track will be created between and used to join the two 

sectional track endpoints.  
 one flex-track endpoint with one sectional track endpoint, the section of flex-track will be extended 

and joined with the sectional track endpoint.  

Any tracks created during the Join command will have the following properties inherited from the first 

track: selected state, hidden state, scale, track gauge and Layer.  



Turnouts and Sectional (Section 2.7) tracks can be joined to other tracks. XTrackCAD extends the 

selected endpoint with a straight track when making the connection.  

A Turntable (Section 2.1.9) can be joined however it must be used as the second endpoint.  

For detail about;  

Using curved flex-track to join track segments refer to Section 2.2.6.1.  

Moving one segment of track to join with another refer to Section 2.2.6.3.  

 

 

 

 

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdHotBar.html#cmdHotBar
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdTurntable.html#cmdTurntable
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/joinTrackCurve.html#joinTrackCurve
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/joinTrackMove.html#joinTrackMove


2.2.6.3 By Moving Track 

This method of joining track may be used to move, align and join one section of track with another.  

 

1. Before initiating the Join command, the track that will be moved, aligned then joined must be selected 
using the Select command (Section 2.2.14).  

 

2. Once the track to be moved is selected, start the join process by clicking on the Join button ( ). 

 

3. Shift+Left-Click the endpoint of one of the two tracks being joined. A red dot will appear as a reminder 
of which track has been selected.  

 

4. Move the mouse pointer over the endpoint of the other track then Shift+Left-Click. The selected track 
will be moved, aligned then joined to the stationary section of track.  

For detail about;  

Using curved flex-track to join track segments refer to Section 2.2.6.1.  

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdSelect.html#cmdSelect
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/joinTrackCurve.html#joinTrackCurve


Using straight flex-track to join track segments refer to Section 2.2.6.2.  
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2.2.7 Modify 

 

The Modify command is used to change characteristics of or extend existing track by adding new 

track. This command works with any unconnected track endpoint.  

The Modify command can be invoked using the Change>Modify menu item, the Modify button or 

the menu raised by a Right-Click over the Main Canvas.  

Either the left mouse button (for changing length or creating a tangent track) or the right mouse button 

(for extending with a new track) is used to modify the unconnected endpoint.  

The endpoints of a Line, Dimension Line, Table Edge or Bench-work can be dragged to new positions. 

A Box is treated as 4 Lines.  

Curved Lines are modified in same manner as curved track.  

Selecting a corner of a Poly Line, Filled Box or Polygon moves that corner to a new position, and if 

moved close to a neighboring corner will merge the two corners and delete the edge between them. 

Selecting an edge will create a corner that can be dragged to a new position.  

Any tracks created during the Modify command will have the following properties inherited from the 

first track: selected state, hidden state, scale, track gauge and Layer.  

For detail about;  

Changing track length refer to Section 2.2.7.1.  

Creating a tangent to a curve refer to Section 2.2.7.2  

Changing track radius refer to Section 2.2.7.3  

Extending track length refer to Section 2.2.7.4  
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2.2.7.1 Changing Track Length 

1. Click the Modify button (  to activate the Modify function.  
2. With the mouse pointer hovering over the endpoint of the object to be modified, Left+Drag (Section 

B.1) to change the length of the track segment, table edge, bench-work, dimension line or line.  

Left+Dragging the endpoint of a turnout (or other sectional track) causes a straight length of flex-track 

to be created from the selected endpoint to the cursor.  

Left+Dragging the endpoint of a Table Edge (Section 2.3) allows the endpoint to be moved to a new 

position. If the endpoint is moved close to another Table Edge then the endpoint will be moved to it.  

The length of a curved track can be changed to form an almost complete circle by selecting one 

endpoint of the curved track then dragging the cursor to the other endpoint. Going past the other 

endpoint creates a very small curve. Curves greater than 360° cannot be created.  

For detail about;  

Creating a tangent to a curve refer to Section 2.2.7.2  

Changing track radius refer to Section 2.2.7.3  

Extending track length refer to Section 2.2.7.4  
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2.2.7.2 Creating a Tangent to a Curve 

1. Click the Modify button ( ) to activate the Modify function.  
2. With the mouse pointer hovering over the endpoint of the object to be modified, Left+Drag (Section 

B.1) to change the length of the track segment.  

If a Left+Drag is continued beyond the radius of a curved track (Section 2.1.2) (not a Circle) a tangent 

to the curve will be created.  

Creation of the tangent begins when the distance from the curved track center to the cursor is greater 

than 110% of the radius. If the cursor is moved within the radius of the curve then the current 

command exits and the Changing Track Length (Section 2.2.7.1) command is executed instead.  

If Easements (Section 2.10.4) are enabled then an easement curve will be generated (if required) to 

connect the old and new tracks.  

For detail about;  

Changing track length refer to Section 2.2.7.1.  

Changing track radius refer to Section 2.2.7.3  

Extending track length refer to Section 2.2.7.4  
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2.2.7.3 Changing Track Radius 

This command is used to change the radius of a curved track or to curve a section of straight track.  

1. Click the Modify button to activate the Modify function.  
2. Shift+Left+Drag the unconnected endpoint of a curved track to change the radius of track segment. 

Alternately, Shift+Left+Drag the unconnected endpoint of a straight track to add a radius to the track 
segment.  

o For this command to work, the endpoint opposite that being manipulated must be connected 
to another track.  

This command can be used to change straight tracks into curved track and vice versa.  

For detail about;  

Changing track length refer to Section 2.2.7.1.  

Creating a tangent to a curve refer to Section 2.2.7.2  

Extending track length refer to Section 2.2.7.4  
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2.2.7.4 Extending Track Length 

This command is used to extend the length of a straight or curved section of track.  

1. Click the Modify button ( ) to activate the Modify function.  
2. With the mouse pointer hovering over the endpoint of the object to be modified, Right+Drag (Section 

B.1) to extend the length of the track segment.  

The selected endpoint determines the position and angle of the first endpoint of the new track. The 

cursor is dragged to set the second endpoint. A curved or straight track will be created, depending on 

the position of the second endpoint.  

If easements (Section 2.10.4) are enabled then an easement curve will be generated (if required) to 

connect the old and new tracks.  

For detail about;  

Changing track length refer to Section 2.2.7.1.  

Creating a tangent to a curve refer to Section 2.2.7.2  

Changing track radius refer to Section 2.2.7.3  

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/windowTerms.html#windowTerms
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/windowTerms.html#windowTerms
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdEasement.html#cmdEasement
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/chgTrackLength.html#chgTrackLength
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/createTangent.html#createTangent
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/chgTrackRadius.html#chgTrackRadius


2.2.8 Move 

 

This command is used to move selected (Section 2.2.14) objects around the layout.  

The Move command can be invoked using the Change>Move menu item or the Move button and 

from the menu that's raised by a Right-Click over the Main Canvas or by the Shift+Left+Drag 

command when in Select mode.  

Successful use of this command requires selection of the object(s) to be moved before attempting to 

move it. An object is selected by using the Left-Click command. A group of connected objects can be 

selected using the Shift+Left-Click command.  

A pop-up menu with commands controlling how objects are drawn during moves can be activated by 

entering a Shift+Right-Click command while hovering over the Main Canvas  

 

Left+Drag is used to move the selected object(s) around the layout.  

Note: The Draw Moving Tracks Radio box on the Command Options (Section 2.10.2) dialog can 

also be used to select how objects are drawn during drags to move or rotate objects. The options for 

this feature are:  

 Normal - objects are drawn normally. This can be time-consuming when using a slow machine and 
moving a large number of objects.  

 Simple - objects are drawn using one line (instead of two when zoomed in). Structures are drawn as 
outlines, no endpoints or lines are drawn.  

 Endpoints - only the endpoints are drawn (as stars).  
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2.2.9 Move Description 

 

This command is used to move Elevation, Grade, Station (Section 2.2.4), Curved Track (Section 

2.1.2), Helix (Section 2.1.4) or Turnout (Section 2.7) Labels.  

The Move Description command can be invoked using the Change>Move Description menu item, 

the Move Description button or the menu raised by a Right-Click over the Main Canvas.  

Click the Move Description button to activate the Move Description command. Use Left+Drag to 

move the label to a new position. Once moved, the label becomes fixed in a position relative to the 

object. Subsequent moves of that object will cause the label to move as well.  

This operation can also be invoked by Ctrl+Left+Drag when in Select mode (Section 2.2.14).  

Shift+Right-Click (Section 3.4) can be used to toggle display of individual Curved Track, Helix or 

Turnout Labels.  
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2.2.10 Profile 

The Profile dialog draws a profile showing elevations, distances and grades for a path on the layout.  

 

Choose a path by using Left-Click on endpoints. As each endpoint is chosen, the path is extended via 

the shortest route. Selecting the end of the path trims the path back to a last Defined Elevation point 

(if any, otherwise the path is cleared).  

If no route is possible an error message is displayed. There are several reasons why this might happen:  

 The tracks are not connected. Check this by using Shift+Left-Click on one track using the Select 
command (Section 2.2.14). This selects all tracks connected (directly or indirectly). See if the other 
track is selected.  

 One of the endpoints on the route is Ignored (Section 2.2.4). Look for blue dots on the expected path 
when using the Profile or Elevation (Section 2.2.4) commands.  

 The only route connects to a section of track that is already on the path and is not the end of the path. 
Remove the end of the path until the connected track is not on the path.  

The path is drawn in the Profile Color (Section 2.10.1) (default Purple) on the layout.  

If the shortest path is not what you want, you can choose endpoints that are closer to the end of the 

path. Also, you can Ignore (Section 2.2.4) endpoints to prevent the path from choosing a route 

through that endpoint. Shift+Right-Click (Section 3.4) displays a pop-up menu that allows you to 

change the specified endpoint to be a Defined, Ignored or None Elevation endpoint.  

Each Defined Elevation endpoint on the path is drawn as a Vertical bar, labeled with its height and 

distance from the beginning of the path.  

The Grade between points is displayed between the vertical bars. The Grade line is drawn in Blue if 

that portion of the path does not contain more than one Shortest Path between Defined Elevation 
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endpoints. Otherwise it is drawn in Red, to indicate the grade is an average and the actual grade may 

vary for any particular track segment. See Computing Dynamic Elevation (Section 2.2.4.1) for more 

details.  

Stations on the path are displayed along the bottom of the Profile.  

The heights of Defined Elevations can be changed by using Left+Drag on the profile window. As you 

Drag, the new elevation and grades to each side are displayed at the bottom of the profile dialog.  

The Done button closes the dialog.  

The Clear button preserves elevation settings established along the current profile path, removes all 

profile points and leaves the Profile dialog open for selection of the next set of profile points. This 

function is useful when there's a need to view elevations along multiple profile paths.  

The Print button prints the dialog. The aspect ratio is preserved on the print-out. You will probably 

want to print in landscape format.  
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2.2.11 Properties 

 

Clicking on the Properties (Describe Mode) button cancels all active commands, closes any open 

dialog windows and places focus on the main window.  

A Left-Click on an object while in Properties mode causes a properties dialog window to appear. The 

properties dialog contains information pertaining to the selected objects position, size, color and layer 

as appropriate for each type of object. Certain values can be changed to modify the object. If a track is 

connected to other tracks, then some values, e.g., endpoint positions, can not be changed.  

 

The selected object is highlighted by a grey area.  

 

Most commands return to Properties mode then they terminate unless the command is sticky (Section 

2.10.8).  

Note: the Default Command radio button on the Command Options (Section 2.10.2) dialog controls 

whether the Properties or the Select (Section 2.2.14) command is used as the default command.  
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2.2.12 Raise or Lower Elevation 

This command allows you to raise or lower the elevation of all selected tracks.  

 

The entered value is added to all Defined Elevations on the Selected tracks. A negative value will 

lower the Elevations.  

 

 

 

 

 

 

 

 

 

 

 



2.2.13 Rotate 

 

This command is used to rotate selected (Section 2.2.14) objects.  

The Rotate command can be invoked using the Change>Rotate menu item, the Rotate button, the 

menu raised by a Right-Click over the Main Canvas or by the Shift+Right+Drag command when in 

Select mode.  

Successful use of this command requires selection of the object(s) to be rotated before attempting to 

rotate it. An object is selected by using the Left-Click command. A group of connected objects can be 

selected using the Shift+Left-Click command.  

A pop-up menu with commands controlling how objects move during the Rotate function can be 

activated by entering a Shift+Right-Click command while hovering over the Main Canvas.  

 

Rotation can be achieved using one of the following methods;  

Left+Drag using the mouse. See Section 2.2.13.1 for detail.  

Selecting fixed or specified degrees of rotation using a Right-Click menu. See Section 2.2.13.2 for 

detail.  

Aligning the selected object with another object on the layout. See Section 2.2.13.3 for detail.  
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2.2.13.1 Using Mouse 

Rotate An Object Using the Mouse  

1. Select the object(s) to be rotated.  

2. Click the Rotate button ( ) to activate the Rotate function.  
3. Visualize an axis point on the object that's to be rotated then place the mouse pointer over that point.  
4. Click and hold the left mouse button then drag (Left+Drag) the mouse away from the axis point to 

create a "handle". This handle will be used to rotate the object. While continuing to hold the left 
mouse button, drag (Left+Drag) the handle in the desired direction of rotation. Note: If the Ctrl key is 
pressed in conjunction with Left+Drag, the object will rotate in increments of 15°.  

5. Release the mouse key once desired rotation is obtained.  

Rotation can also be achieved through use of one of these alternate methods;  

Selecting fixed or specified degrees of rotation using a Right-Click menu. See Section 2.2.13.2 for 

detail.  

Aligning the selected object with another object on the layout. See Section 2.2.13.3 for detail.  
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2.2.13.2 Using Degree's of Rotation 

Rotate An Object Using Fixed or Specified Degree's of Rotation  

A pop-up menu with additional menu items allows you to Rotate the selected object(s) through 

various predefined angles or through any angle you specify. The Rotate command is executed as 

follows;  

1. Select the object(s) to be rotated.  

2. Click the Rotate button ( ) to activate the Rotate function.  
3. With the mouse pointer hovering over the object to be rotated, Shift+Right-Click to raise the Rotate 

menu then select the desired degree and direction of rotation from the list of predefined angles (180°, 
90° CW, 45° CW, 30° CW, 15° CW, 15° CCW, 30° CCW, 45° CCW, 90° CCW).  

 

Alternately, any angle may be entered by Left-Clicking the Enter Angle... menu item then 

entering a desired angle in the Rotate dialog window that appears.  

 

Rotation can also be achieved through use of one of these alternate methods;  

Left+Drag using the mouse. See Section 2.2.13.1 for detail.  

Aligning the selected object with another object on the layout. See Section 2.2.13.3 for detail.  
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2.2.13.3 Aligned With Another Object 

Rotate and Align An Object With Another Object  

A pop-up menu with additional menu items allows you to Align the selected object(s) with any other 

object on the layout. The Align command is executed as follows;  

1. Select the object(s) to be rotated.  

2. Click the Rotate button ( ) to activate the Rotate function.  
3. With the mouse pointer hovering over the object to be rotated, Shift+Right-Click to raise the Rotate 

menu then select Align.  

 

4. Left-Click on the (selected) object that is to be rotated.  
5. Left-Click on the object with which you want the selected object aligned. The selected object will 

rotate to align with the reference object.  

Rotation can also be achieved through use of one of these alternate methods;  

Left+Drag using the mouse. See Section 2.2.13.1 for detail.  

Selecting fixed or specified degrees of rotation using a Right-Click menu. See Section 2.2.13.2 for 

detail.  
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2.2.14 Select 

 

Clicking on the Select button cancels all active commands, closes any open dialog windows and 

places focus on the main window.  

In combination with the mouse, the Select command can be used as follows;  

Left-Click - selects an object (or unselects a selected object). Selected objects appear in red (unless 

changed in the Color (Section 2.10.1) dialog).  

Shift+Left-Click - selects all unselected tracks connected to the track you select. Selection stops at 

selected tracks. Caution: This can select all tracks on the layout.  

Left+Drag - highlights an area, and all objects within the area are selected.  

Right-Click - displays a pop-up menu of commands.  

 

 

or  

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdRgbcolor.html#cmdRgbcolor


Shift+Right-Click (Section 3.4) - displays a pop-up menu of options controlling how objects are drawn 

during moves and rotates (below). If there are selected objects then additional menu items allow you 

to rotate the selected objects by various angles.  

Right+Drag - highlights an area, and all objects within the area are unselected.  

Shift+Left-Click+Drag - moves the selected objects (the Move (Section 2.2.8) command).  

Shift+Right-Click+Drag - rotates the selected objects (the Rotate (Section 2.2.13) command).  

 If the Ctrl key is pressed while dragging then rotation will occur in 15° increments.  

Ctrl+Left-Click+Drag - moves turnout and elevations labels (Also see the Move Description (Section 

2.2.9) command).  

The following commands operate on the objects you have selected:  

 Move (Section 2.2.8) the selected objects.  
 Rotate (Section 2.2.13) the selected objects.  
 Flip (Section 2.2.5) (mirrors) the selected objects.  
 Delete (Section 2.4.3) selected objects.  
 Hide (or unhide) in a Tunnel (Section 2.4.4).  
 Move Above or Below (Section 2.4.1).  
 Parts List (Section 2.9.5) of the selected objects.  
 Change the width of the tracks' rails.  
 Export (Section 2.5.1) the selected objects.  
 Creates a structure or turnout definition from Grouped (Section 2.9.3) objects.  
 Rescale (Section 2.2.1) the selected objects.  

The Cut, Copy and Paste commands found on the Edit (Section 2.4) menu will also operate on 

selected objects.  

Notes:  

 A Filled Shape (Section 2.3) can be selected by clicking on its edge.  

 Connections between selected and unselected tracks will be broken when selected tracks are moved. 
If the Drawing Scale is 8:1 or smaller, these about-to-be broken connections are marked with a red X.  

 The Select All item on the Edit (Section 2.4) menu can be used to select all objects on the layout.  

 The Default Command radio button on the Command Options (Section 2.10.2) dialog controls whether 
the Properties (Section 2.2.11) or Select command is used as the default command.  

 Pressing the Escape key will deselect all selected tracks.  

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdAcclKeys.html#cmdAcclKeys
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdMove.html#cmdMove
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdRotate.html#cmdRotate
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdMoveLabel.html#cmdMoveLabel
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdMoveLabel.html#cmdMoveLabel
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdMove.html#cmdMove
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdRotate.html#cmdRotate
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdFlip.html#cmdFlip
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdDelete.html#cmdDelete
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdTunnel.html#cmdTunnel
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdAboveBelow.html#cmdAboveBelow
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdEnum.html#cmdEnum
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdExport.html#cmdExport
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdGroup.html#cmdGroup
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdRescale.html#cmdRescale
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/editM.html#editM
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdDraw.html#cmdDraw
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/editM.html#editM
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdCmdopt.html#cmdCmdopt
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdDescribe.html#cmdDescribe


2.2.15 Split Track 

 

The Split command provides several functions. It can be used to disconnect the joint between two 

sections of connected track, to divide a section of track into two pieces at a selected point or to place 

block gaps at an existing joint.  

For detail about;  

Disconnecting the joint between two sections of track see Section 2.2.15.1.  

Dividing a section of track into two connected pieces see Section 2.2.15.2.  

Creating block gaps at an existing joint see Section 2.2.15.3.  
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2.2.15.1 Disconnect Joint 

Disconnecting a joint between two pieces of connected track;  

1. Click the Split button ( ) to activate the Split command.  
2. Place the mouse pointer over the joint between the two track endpoints then Left-Click.  

When the Split command completes, the joint at the two track endpoints will show three lines rather 

than one. The three lines represent abutted, disconnected track endpoints.  

 

Joint prior to split  

 

Joint following split  

For detail about;  

Dividing a section of track into two connected pieces see Section 2.2.15.2.  

Creating block gaps at an existing joint see Section 2.2.15.3.  
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2.2.15.2 Divide Track 

Dividing a section of track into two connected pieces;  

1. Click the Split button ( ) to activate the Split command.  
2. Place the mouse pointer over the point on the track where the it should be divided then Left-Click.  

When the Split command completes, a connected joint will appear in the track at the point of 

selection. To split and disconnect at a point, execute the Split track command twice. The first 

command will split the track, the second command will disconnect it.  

 

Track prior to split  

 

Track following split  

It's not possible to create a track shorter than the Minimum Track Length (Section 2.10.7).  

This command is useful for placing tunnel portals or elevation points (Section 2.2.4) at specific track 

locations.  

Normally a turnout cannot be split however, if the Shift key is held when executing this command then 

the turnout can be trimmed. Trimming replaces the portion of track between the split point and the 

turnouts endpoint with flex-track. For turnouts with more than one set of points (Section B.2), such as 

a slip switch or scissors crossover, a trim point cannot be selected between the points of the turnout.  

For detail about;  

Disconnecting the joint between two sections of track see Section 2.2.15.1.  

Creating block gaps at an existing joint see Section 2.2.15.3.  
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2.2.15.3 Adding Block Gaps 

The Split command can be used to add block gaps (Section B.2) at the point where two track 

endpoints join. Block gaps are drawn as a thick line and can be placed in either of the rails or both if 

total isolation is required.  

 

No Block Gaps  

 

Block Gap in top rail  

 

Block Gap in bottom rail  

 

Block Gaps in both rails  

After executing the Split command use the Shift+Right-Click command to display one of two pop-up 

menus which can be used to add, change or remove block gaps for the selected endpoint.  

 

This menu appears if track runs in a horizontal direction.  
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This menu appears if track runs in a vertical direction.  

For detail about;  

Disconnecting the joint between two sections of track see Section 2.2.15.1.  

Dividing a section of track into two connected pieces see Section 2.2.15.2.  
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2.3 Draw Menu 

Draw commands are used to draw lines, arcs and other shapes. These can be used to represent water 

edges, bridges and other scenic features.  

 

There are 4 command buttons on the tool-bar used to draw Straight Objects, Curved Lines, Circles and 

other Shapes. Each command button is followed by a button that changes the action (and Icon) on the 

command button.  

 

Functions for drawing basic shapes and objects like lines and curves can be accessed from this menu.  

Circle Lines - draw empty or filled circles.  

Curved Lines - are created in the same manner as curved tracks.  

Note - attach a note icon to a specific location on the layout.  

Ruler - create ruler and set visibility (Section 2.3.4)  

Shapes - draw boxes and poly-lines.  

Straight Objects - draw straight objects.  

Text - allows entry of text directly onto the layout.  

Some commands display controls on the Status Line (Section 3.1) to change line width, color or other 

attributes of the object.  
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2.3.1 Circles and Filled Circles 

 

Circles and Filled Circles are created by selecting either the center position or a point on the edge of 

the circle and dragging to specify the radius.  

Select a point on the edge of the circle and drag to the center.  

Select the center and drag to set the radius.  

 

 

 

 

 

 

 

 

 

 

 



2.3.2 Curved Lines 

 

Curved Lines are created in the same manner as curved tracks.  

Select the start of the curve and drag in the direction of the curve.  

Select one end of the curve and drag to the center.  

Select the center of the curve and drag to one end.  

Drag from one end of the curve to the other to form the chord of the curve.  

To complete the command, drag on the red arrows to adjust the curve.  

 

 

 

 

 

 

 

 

 



2.3.3 Note 

 

The Notepad command allows you to attach notes ( ) to selected places on the layout.  

Click and drag on the Main Canvas (Section 3.1) to place the note.  

When you release, the Note Editor dialog is displayed. You can enter the note in the text area.  

When in Properties (Section 2.2.11) mode, clicking on a Note will display the Property Sheet to let 

you read or modify the note.  
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2.3.4 Ruler 

 

The Ruler command displays a ruler on the layout. Click where you want the ruler to begin and drag 

the cursor to measure distances from the origin. The measured length is displayed in the Status-bar 

(Section 3.1).  

You can use the Modify (Section 2.2.7) command to change the length of the Ruler.  

Subsequent clicks on the Ruler button will hide or display the ruler.  
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2.3.5 Shapes 

 

Shapes are drawn by:  

Boxes and Filled Boxes are created by selecting one corner and dragging the 

opposite corner. A Box is composed of four lines which may be individually deleted.  

Poly Lines and Polygons are created by Left+Drag, and a corner is placed 

when you release the left mouse button. The Poly shape is finished by pressing the Space key 

or by selecting another operation.  

 
 

 

 

 

 

 

 

 

 

 



2.3.6 Straight Objects 

 

Straight Objects are created by a Left+Drag (Section B.1) on the layout. If Draw Straight Objects is 

Sticky (Section 2.10.8), Shift+Left+Drag will use the endpoint of the previous line as the starting 

point.  

Creates a Straight Line of specified color and width.  

Creates a Dimension Line of various sizes.  

Creates Bench-work using different types and orientation of lumber.  

Creates a Table Edge  

Bench-work Notes  

Lumber is drawn using the Dressed size which is 0.25" smaller than the indicated size: a 1" x 2" 

actually measures 0.75" x 1.75". The drawn height of Girders is 0.5" smaller.  

Girders can be drawn in a variety of orientations: normal, inverted or rotated. L-Girders can be drawn 

with the flange to the Left or Right.  

When using metric units (Section 2.10.7), a 1" x 2" is labeled 50mm x 25mm  
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2.3.7 Text 

 

The Text command lets you enter text on the layout at the selected position.  

 

The font size can be changed by the Font Size drop list on the Status-bar (Section 3.1). The font size 

is scaled along with everything else on the layout so text is always the same relative size as other 

layout objects.  

The font can be selected by the Font Selection (Section 2.10.5) dialog invoked by the Options>Fonts 

menu item or by Shift+Right-Click (Section 3.4).  

The position where text is to be placed on the layout must be selected prior to text entry. The position 

is select by Left-Clicking on the layout at the point where the text is to appear. Desired text is entered 

after the position is selected. If necessary, the location can be changed once text entry begins by Left-

Click+Draging the text to any desired postion on the layout.  

The Properties (Section 2.2.11) command can be used to modify the contents of existing Text 

objects.  

Note: loading fonts (or changing sizes) can take a noticeable amount of time.  
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2.4 Edit Menu 

 

The Edit Menu shows commands affecting the Main Canvas (Section 3.1).  

Above - Moves selected object to foreground.  

Below - Moves selected object to background.  

Copy - Copies the selected objects to the clipboard.  

Cut - Moves the selected objects to the clipboard.  

Delete - Deletes the selected objects.  

Deselect All - unselects all objects on the layout. The same action can be achieved by pressing the ESC 

key.  

Invert Selection - selects all unselected objects and unselects all previously selected objects.  

Move To Current Layer - move all selected objects to the current Layer (Section 2.9.4).  

Paste - Copies the contents of the clipboard to the layout. The newly pasted parts are in Selected state 

and can easily be moved into place. Any previously selected objects are unselected.  

Redo - Undoes the last Undo command. The Redo command can also be invoked by the Redo button 

(Section 2.4.5).  
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Select All - Selects all objects on the layout.  

Select Current Layer - selects all objects in the current Layer (Section 2.9.4).  

Select Stranded Track - selects all track pieces that are not connected to any other objects. This helps 

cleaning up a drawing after many changes have been made.  

Thin, Medium and Thick Tracks - set rail width of selected tracks.  

Tunnel - Hides or reveals selected tracks.  

Undo - Undoes the last command. Up to the last ten commands can be undone. If there are no 

commands that can be undone the Undo item is disabled. The Undo command can also be invoked by 

the Undo button (Section 2.4.5).  

For more information on working with selected objects, see the Select (Section 2.2.14) command.  
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2.4.1 Above and Below 

 

The Above/Below commands move the selected objects (Section 2.2.14) into the Foreground or 

Background making them more or less visible or prominent.  

The effect is to make the objects appear in front or behind other objects. This command is most useful 

when dealing with filled shapes (Section 2.3).  

Selected objects moved to the Background become unselected.  
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2.4.2 Additional Shortcut Keys 

Additional Shortcut keys perform the following:  

Shift+Backspace - Undo  

Ctrl+Insert - Copy  

Shift+Insert - Paste  

Shift+Delete - Cut  

Esc - Deselect All  

 
 

 

 

 

 

 

 

 

 

 

 

 

 



2.4.3 Delete 

 

The Delete button is used to delete selected objects. Remember, the Undo (Section 2.4 or Section 

2.4.5) command can be used to restore a delete object.  

Deleting a track that is connected to an easement (Section 2.10.4) causes the easement to be deleted as 

well.  

The Delete key invokes the Delete command.  
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2.4.4 Tunnel (Hide Tracks) 

 

The Tunnel command is used to hide selected (Section 2.2.14) tracks (as in a tunnel).  

Select the tracks you want to hide in a tunnel. Selecting a hidden track 'reveals' it.  

A tunnel portal is drawn where a hidden track connects with an 'unhidden' track. You can split 

(Section 2.2.15) a track to place a tunnel portal at a particular spot.  

The Draw Tunnels Radio button group on the Options>Display dialog (Section 2.10.3) controls 

whether hidden tracks are not drawn, drawn as dashed lines or drawn as normal lines.  

 

2.4.5 Undo and Redo 

 

The Undo and Redo buttons invoke the same actions as the Edit menu items. The name of last 

command will be displayed as the Balloon Help (Section B.1) for the Undo button. The name of last 

undone command will be displayed as the Balloon Help for the Redo button.  
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2.5 File Menu 

 

The File Menu shows file oriented commands for loading and saving layout files.  

Exit - Exits XTrackCAD. You will be asked to confirm your choice if there are unsaved changes.  

Export - Exports the selected objects to a file in XTrackCAD (*.xti) format. The exported file can then 

be imported into another layout design. Refer to the Import command listed above.  

Export to Bitmap - Creates a bitmap file (Section 2.5.2) of the layout.  

Export to DXF - Exports the selected objects to a file in DXF format (Section B.2). The exported file can 

then be imported into other CAD programs.  

File List - List of the five most recently used XTrackCAD files.  

Import - Displays the file selection dialog which allows selection of an existing XTrackCAD Import 

(Section 2.5.1) file. This function can be used to transfer parts like a yard design from one layout 

design to another.  

New - Clears the current layout. In case there are any unsaved changes on the current plan, a 

warning pop-up will be displayed and you'll have the option to cancel the operation.  

Notes - Displays a simple notepad editor which you can use to enter information about the layout. 

Typically this could include prototype, period, theme, layout style, height, construction, type of track 
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and turnouts used, control system and anything else of interest. (There is also a Note command 

(Section 2.3.3) which allows attaching notes to particular parts of the layout.)  

Open - Displays the File Open dialog which allows an existing XTrackCAD file to be selected and 

opened. In case there are any unsaved changes on the current plan, a warning pop-up will be 

displayed and you'll have the option to cancel the operation.  

Parameter Files - Displays the Parameter Files dialog (Section 2.5.5) to choose parameter files.  

Print Setup - Shows the Printer Setup Dialog (Section 2.5.7).  

Print - Invokes the Print command (Section 2.5.6).  

Revert - Undoes all changes and returns to the last saved layout plan.  

Save - Saves the layout under the current file name. If a filename has not yet been assigned then 

the File Save dialog is shown so you enter a file name.  

Save As - This command lets you make a copy of the track plan you are currently working on. It differs 

from the regular Save command. Save stores your data back into the folder (directory) it originally 

came from. "Save As" lets you give your plan a different name and/or put it in a different folder on 

your hard disk or floppy disk.  
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2.5.1 Export 

This menu item displays a file selection dialog where a file name for exported objects can be entered. 

All selected (Section 2.2.14) objects are exported to the file. The export file will have an xti 

extension.  

 

Using the Import command (section 2.5.4), an exported file can be imported into another layout 

design.  
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2.5.2 Export to Bitmap 

This menu item creates a bitmap file of the layout.  

 

The Bitmap dialog specifies the style and size of the bitmap. The three check-boxes (Print Titles, 

Print Borders and Print Centerline) control whether the Layout Title (Section 2.10.6), the borders or 

the track centerlines are printed on the bitmap. The size of the bitmap is smaller if these are disabled.  

Printing the track centerlines (also seen when zoomed in 1:1) is useful when you later print the bitmap 

full size for laying out track.  

If the Snap Grid (Section 2.12.1) is visible then it will be printed on the bitmap.  

The DPI (or DPCM if using metric units (Section 2.10.7)) control specifies the number of pixels per 

inch (or centimeter) in the bitmap. You can enter values from 0.1 to 100. Larger values will result in a 

larger bitmap file. bitmaps must be less than 32000 pixels in height or width.  

The bitmap width, height and approximate file size is indicated.  

Note: This command can create a very large file and consume a lot of memory and time.  

Pressing the OK button invokes a File Save dialog so you can choose the file name for the Bitmap.  

The format of the file depends on the Operating System: on MS-Windows it is a Windows Bitmap 

(.BMP) file, on Linux it is a X11 Pixmap (.XPM) file.  
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2.5.3 Export to DXF 

This menu item displays a file selection dialog where a file name for exported objects can be entered. 

All selected (Section 2.2.14) objects are exported to the file. The export file will have an xti 

extension.  

 

Exported files can then be imported into other CAD programs.  
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2.5.4 Import 

Importing displays a file selection dialog to specify the file to import.  

 

After importing the objects from the file, the imported objects are in selected state and therefore are 

drawn in red. This allows you to easily move and rotate the imported objects to their final position.  

 
 

 

 

 

 



2.5.5 Parameter Files 

Parameter Files contain turnout, sectional track and structure definitions. Parameter Files are loaded 

and unloaded with the Parameter Files dialog.  

 

The dialog contains a list of parameter files. Each file is preceded by a checked box. If the box is 

checked, the parameter file is loaded. If the box is not checked the file is unloaded.  

Loaded definition files associated with current scale settings appear on the Hot Bar (Section 2.7). If 

you unload a file the definitions are removed from the selection lists and the Hot Bar. An unloaded 

file may be reloaded by selecting the Reload button (The Unload button changes to Reload when a 

selected file is unloaded).  

Unloaded files are removed from the list when XTrackCAD terminates.  

Files can be listed by either their file name or by their contents description. This is controlled by the 

Show File Names check box.  

The Browse button allows you to load other parameter files such as provided by other users or 

downloaded from the Internet.  

When first installed, all available parameter files are loaded. You can unload parameter files you don't 

use to speed up XTrackCAD startup time.  

The order in this list controls the order of turnouts and structures on the Hot Bar (Section 2.7). You 

can move a parameter file to the end of the list by Unloading it, and then loading it via the Browse 

button.  
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2.5.6 Printing 

The Print command (File>Print) is used to print all or a portion of the layout.  

When the Print command is selected a grid, which represents each printed page, is drawn on the 

layout. Pages can be selected or unselected for printing by placing the mouse over a grid section and 

clicking the left mouse button.  

 

The Print dialog contains a number of control areas:  

The size of each page is controlled by:  

Scale - up to 1:1.  

Width, Height - scaled size of each page. Values for Width and Height can be manually entered, 

overriding the maximum values. Values larger than the page size times the Scale cannot be entered.  

Max - sets Width and Height to the maximum for the print Scale.  

Snap Shot - adjusts the Scale, Origin and Angle to produce a one-page snap shot of the layout.  

Format - Portrait or Landscape.  



Page printing order is controlled by the Print Order option.  

Relative to the Print Grid:  

Normal order is Columns first, Top to Bottom, Left to Right.  

Reverse order is Rows first, Left to Right, Bottom to Top.  

Whether tracks are printed with one or two lines (representing the center line and rails) depends on the 

Print Scale. If this value is smaller than or equal to twice the Two Rail Scale on the Display (Section 

2.10.3) dialog then tracks are drawn with two lines. This corresponds to the way tracks are drawn on 

the main window, adjusted to account for the greater resolution of most printers. At 1:1 tracks are also 

drawn with a center line.  

Other options:  

Engineering Data - show title, user, date and other information in a box at the bottom of the printout.  

Ignore Page Margins - use the physical page size. This allows the printouts to abut without trimming.  

Print Registration Marks - at 1:1 scale, print location markers every 3" (or 10cm). This option is only 

enabled at 1:1. This is useful for aligning multiple pages printed at different angles.  

Print Snap Grid - if the Snap Grid (Section 2.12.1) is visible then it may be drawn on the printout. This 

option is only enabled if the Snap Grid is visible.  

Print Rulers - print rulers on all edges of the page. This option is only enabled if the Angle is 0.000.  

Print Roadbed Outline - lines representing the edge of the Roadbed. The Roadbed will be printed if 

the Width is greater than the track gauge. Note: this option is most useful at 1:1. This option is 

disabled if tracks would be drawn with only one line (instead of two).  

The orientation of the print grid is controlled by:  

X - X co-ordinate.  

Y - Y co-ordinate.  

Angle - of the grid.  

These values can be set directly or by dragging on the layout. Shift+Left+Drag moves the grid and 

Shift+Right+Drag rotates the grid. The Reset button resets the values to 0.  

The Print button prints the selected pages and closes the Print dialog. It is not enabled until you have 

selected some pages to print.  

The Setup button invokes the Printer Setup (Section 2.5.7) dialog.  
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The Clear button unselects all selected pages.  

Suggested Uses:  

Use the Snapshot button to set the scale and orientation for a one-page printout of the layout. Also set 

Engineering Data to add the Layout Title, Scale and other data for a summary.  

Use Layers (Section 2.9.4) to control which tracks are visible (and printed). Put bench-work, scenery 

or different tracks levels in separate layers and hide the layers you are not working with.  

To transfer the drawing to the layout without printing at 1:1, make the Snap Grid (Section 2.12.1) 

visible and orient it to match your room or layout table.  

Check the Print Snap Grid toggle and use the printed grid to transfer measurements to your layout 

space. You may want to change the color (Section 2.10.1) of the Snap Grid to make it more visible on 

the printout.  

When you print multiple pages you can check Ignore Page Margins so pages can be placed next to 

each other. The tracks will line up correctly without trimming or overlapping the pages. Note: 

depending on your printer there will be an unprintable margin around the edge of the page.  

If you print at 1:1 for direct transfer to the sub-roadbed, check Print Roadbed Outline and set Width 

to show lines for making cuts.  

If you make printouts in strips at different angles at 1:1 (to follow tracks around a curve), check Print 

Registration Marks to be able to align the separate strips.  
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2.5.7 Printer Setup 

2.5.7.1 Linux 

 

The Printer Setup dialog allows you to configure the application's use of the printer.  

The Printer Setup window contains:  

Printer - a list to select a particular printer. The entries on this list are defined by printer 

lines in the ~/.xtrkcad/xtrkcad.rc file. The first entry, 'File', causes printouts to be sent to a 

file. You will be prompted for a file name when doing a print.  

Paper Size - a list of various North American and European paper sizes.  

Margins - non-printable margins for particular printers. You can adjust these entries or select a 

printer type from the list. To add margins for a new printer, enter the printer's name and then 

enter the margin for each edge. You can use Print Test Page to determine the margins for your 

printer.  

The Delete button removes a printer from the margin list.  

Format - a Radio button to select either Landscape or Portrait format.  

X Font and PS Font - specifies the mapping between the displays X Font and the 

corresponding Postscript Font. You can change the Postscript font for a specified X Font by 

typing the new font name in the PS Font field. The font alias map will be printed on the Print 

Test Page.  



Factor - adjusts the scaling between X Font and Postscript Font sizes. Due to differences 

between the two font systems, text size may be of slightly different between the display and 

printer. This option allows you to adjust the font size. Normally only a small adjustment is 

required, (like 0.950).  

OK - updates the data and ends the dialog.  

Cancel - ends the dialog without update.  

Print Test Page - prints a test page you can use to determine the printer margins.  

The formats of the printer entries are:  

PRINTER.Iprinter-num: Iprinter-name=Icommand  

where:  

Iprinter-num is the next value in a sequential list (starting at 1, 0 is reserved for FILE). 

printer.1 is predefined as lp=lpr -P%s.  

Iprinter-name is the name of the printer as it appears in the Printer selection list.  

Icommand is the command to invoke where %s will be replaced by the Iprinter-name.  

To add a new printer, select the next value for Iprinter-num and add the printer line with the name and 

print command.  

Printing generates Postscript data which is sent to the specified printer (or File). The names of fonts 

differs between the X Window System and Postscript and there is no formula to convert them. The 

printing system uses a font alias map to convert from X font names to Postscript font names. Font 

aliases for the common Postscript fonts are predefined but you must supply an alias for unknown 

fonts. The 'Font Alias' window will be shown whenever you are printing an unknown font. You will be 

asked to supply a Postscript font name for a X font. You can change the font alias mapping by using 

the X Font and PS Font entries on the Printer Setup dialog.  

 
 

 

 

 

 

 



2.5.7.2 Microsoft Windows 

 

The Windows Printer Setup dialog allows you to configure the application's use of the printer.  

The Printer Setup window contains:  

Name - a drop down list for selection of a particular printer. Entries in this list are defined by 

Windows.  

Status - the current status of the selected printer.  

Type - the type and model of printer selected.  

Where - The location of the printer if it's defined in the printers properties.  

Comment - Any comments defined that are defined in the printers properties.  

Paper Size - a list of various North American and European paper sizes.  

Paper Source - a list of various paper tray locations associated with the selected printer.  

Orientation - a Radio button to select either Landscape or Portrait format.  

 
 

 

 

 



2.6 Help Menu 

 

The Help Menu displays information on various topics. The contents of the menu vary depending on 

the operating system.  

 

Demo Menu  

The Demos command (Section 2.6.1) opens a cascading menu which invokes various demonstrations 

of XTrackCAD features.  

 

Recent Messages  

The Recent Messages command opens a cascading menu containing recent error messages and 

notices you have received. Selecting one of them displays additional information about the message 

(Section C.2).  
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Tip of The Day  

The Tip of the Day item displays a useful tip about the operation of XTrackCAD. By default, a new 

tip is displayed each time you start the program.  

 

 

 

 

 

 

 

 

 



2.6.1 Demo Mode 

The Demos menu item, under the Help (Section 2.6) menu, shows a cascading menu of choices to 

demonstrate various features and commands.  

 

In demonstration mode XTrackCAD is driven by a script file (such as created by the Record (Section 

2.8) command). The cursor is simulated on the Main Window (Section 3.1) and the XTrackCAD 

windows (except the Demo window) are inactive. Also, simulated input on dialogs is indicated by a 

border momentarily drawn around the control.  

The Demo dialog is displayed which contains a number of control buttons and a text area that shows 

comments on the demonstration being run.  
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 Next - skip to the next demonstration. If you hold down the Shift key then you will jump back to the 
previous demonstration.  

 Quit - quit demonstration mode.  

 Speed - controls the speed of the demonstration.  

 Step - advance to the next step of the current demonstration.  

The state of the layout is saved when running demonstrations.  

A number of options and controls (such as scale) are changed while running demonstrations. These 

will be restored when the demonstration is finished.  

You can adjust Window sizes and positions while the demonstration is running to better see what is 

happening.  

 

 

 

 

 

 

 

 

 

 



2.7 Hot Bar 

 

The Hot Bar is a scrolling list of all the turnouts, sectional track and structures available through the 

Turnout (Section 2.1.8) and Structure (Section 2.1.7) commands. The Description and/or Part Number 

under each object can be displayed by enabling the Hot Bar Labels radio button on the Display 

(Section 2.10.3) dialog.  

The arrow buttons on either side of the Hot bar move the list one object to the right or left. Holding 

down the Shift key will move the list by greater amounts. About eight Shift+Clicks are required to 

move the list through the entire range of objects. Also, pressing the keys 1 through 9 and 0 will cause 

the Hot Bar to jump relative spots on the list.  

A Right-Click over the Hot Bar will display a pop-up menu listing the contents of the Hot Bar. 

Selecting an item from this list causes the Hot Bar to jump to the relative spot on the list.  

Objects on the Hot Bar are placed on the drawing canvas by first clicking on the object, Dragging it 

the Main window, positioning it then pressing the Space key to set it in place.  
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2.7.1 Structures 

Structures are placed on the layout in the same way as turnouts (Section 2.7.2) except no active 

endpoint exists and they do not align with existing track.  

Refer to Section 2.1.7 for information pertaining to use of the Structure dialog.  
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2.7.2 Turnouts 

Turnouts have an active endpoint (Section B.2) which is the handle used to position the Turnout. You 

can change the active endpoint by a Shift+Left-Click which causes the next endpoint to become 

Active.  

If you Left+Drag a turnout onto a track, the active endpoint (Section B.2) is aligned with the selected 

track. On flex-track, you can flip the turnout by moving the cursor from one side of the track 

centerline to the other. On another turnout, the new turnout will be placed at the endpoint closest to the 

cursor.  

XTrackCAD will automatically connect the turnout's endpoints to any other tracks they are aligned 

with. The number of endpoints that will be connected is displayed on the Status Bar, as well as the 

Maximum displacement between these endpoints and the tracks they will be connected to. 

XTrackCAD will adjust the position of the Turnout to give you the best fit for locating the turnout. 

You can override this adjustment by holding down the Shift key while Dragging.  

Right+Drag (Section B.1) can be used to rotate the turnout on the layout. Shift+Right-Click (Section 

3.4) displays a pop-up menu allowing you to rotate the turnout by various angles.  

When you press the Space key, the turnout is positioned on the layout. Any tracks that are aligned with 

any of the turnout's endpoints will be connected to the turnout automatically. If you are using the 

Turnout (Section 2.1.8) command then you can also click the OK button on the dialog.  

If you choose another turnout or change commands after beginning to place a turnout on the layout, 

the turnout will be created as if it is attached to another track. Otherwise it will be removed.  

If the Drawing Scale is smaller or equal to the Label Scale (Section 2.10.3) then Turnouts will be 

labeled with their description when drawn. The individual labels can be can be turned off by the Move 

Description(Section 2.2.9) command, or all Turnout labels can be disabled by using the Display 

(Section 2.10.3) dialog. As well, the length of any connected Flex-track will be indicated at each 

endpoint.  

Refer to Section 2.1.8 for information pertaining to use of the Turnout dialog.  
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2.8 Macro Menu 

 

The Macro Menu shows commands that can be used to Record and Playback commands.  

Record - Displays the Record dialog (after prompting for a file name). The current layout 

state and most subsequent actions will be saved in the recording file.  

 Messages can be inserted into the recording file by pressing the Message button on the 

Record dialog then entering a message in the text display.  

 Press the End button to end entry of the message and resume recording.  

 Press the Stop button to stop recording.  

Playback - Displays the Playback dialog (after prompting for a file name). This is used to 

playback previously recorded sessions. Note: the layout state will be saved during playbacks 

and restored after.  

The Record command is useful if it becomes necessary to report a bug in XTrackCAD.  

 

 

 

 

 

 

 

 



2.9 Manage Menu 

 

The Manage Menu shows commands affecting the Main Canvas (Section 3.1).  

Car Inventory - displays the dialog (Section 2.9.1) to update your list of cars and locomotives.  

Custom Management - displays the Custom Management (Section 2.9.2) dialog to manipulate custom 

turnout, structure and rolling stock designs.  

Group - creates a Structure or Turnout definition from the selected (Section 2.2.14) objects. See the 

Group command (Section 2.9.3) for details.  

Layers - displays the Layer (Section 2.9.4) dialog.  

Parts List - Invokes the Parts List (Section 2.9.5) command. This command produces a list of all 

selected turnouts and sectional tracks and the total length of flex-track.  

Price List - Displays the Price List (Section 2.9.6) dialog to specify prices for tracks and structures.  

Train - Run trains on the designed layout  

Turnout Designer - displays a menu list of Turnout Designer (Section 2.9.8) dialogs.  

Ungroup - breaks apart any selected (Section 2.2.14) turnouts and structures into their basic lines 

(Section 2.3) and track segments.  

Update Turnout and Structures - replaces (Section 2.9.9) any selected (Section 2.2.14) Turnouts and 

Structures with the definitions from updated parameter files (Section 2.5.5).  
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2.9.1 Car Inventory 

This dialog is used to manage your list of cars and locomotives.  

 

The main part of this dialog contains a detailed list of each car and locomotive in your inventory. The 

list can be sorted on different columns by selecting column names in the Sort Drop Down Lists along 

the top of the dialog. The width of the columns can be adjusted by Left+Drag on the lines between the 

column titles.  

Cars are placed on the layout by using the Train Simulation (Section 2.9.7) command.  

The Find button will center the Main Window (Section 3.1) on the selected car. This button is only 

enabled for cars which are on the Layout (indicated by Layout in the Location column). If the car on a 

track that is hidden and Trains on Hidden Track (Section 2.10.3) is set to Hide, then the car (and any 

attached cars) will be made visible.  

The Edit button invokes the Car dialog (Section 2.9.1.1) to modify the selected car. This button is 

disabled if more than one (or no) car is selected or if the selected car is on the Layout. This dialog is 

also used to Add a new Car. Refer to Section A.3 if an error occurs when attempting to add inventory 

to this list.  

The Delete button removes the selected cars from your inventory. This button is disabled if any of the 

selected cars are on the layout.  

The Import and Export buttons read and write a Comma-Separated-Value (CSV) file. This file format 

can be read and written by many applications. It can be used to transfer car inventory data between 

different applications. This file contains the following columns (the first four are required when 

Importing):  
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Scale - example: HO, HOn3, N, O etc  

Manufacturer and Partno  

Prototype - example: GP40  

Index - an unique numeric identifier (optional)  

Roadname, Repmark and Number - example: Burlington Northern, BN, 1234  

Type - enter one of the following:  

 10101(Diesel),  

 10201(Steam),  

 10301(Electric),  

 30100(Freight),  

 50100(Passenger),  

 70100(M-O-W) or;  

 90100(Other)  

Options - 2 (Locomotives), 4 (Body Mounted Couplers)  

CarLength, CarWidth, CoupledLength and TruckCenter - car dimensions in inches  

Color - encoded as (Red * 65535 + Green * 256 + Blue)  

PurchPrice, CurrPrice, PurchDate and ServiceDate - numeric values  

Condition - enter one of the following:  

 100(Mint),  

 80(Excellent),  

 60(Good),  

 40(Fair),  

 20(Poor) or;  

 0(N/A)  

Notes - free form text  

The List button creates a text file listing your inventory.  

 

 

 



2.9.1.1 Car Item Dialog 

This dialog is invoked from the Car Inventory (Section 2.9.1) and the Custom Management 

(Section 2.9.2) dialogs.  

The dialog can be displayed in three different ways and is used to create or edit Car Items, Car Part 

definitions or Prototype definitions.  

The Add button creates a new definition. The dialog remains open so you can enter multiple 

definitions. You can Close the dialog when you are finished. If you are editing an existing definition 

then the Add button will be replaced by the Update button which updates the selected definition and 

closes the dialog.  

The New button on the Car Item dialog invokes the Car Part or Car Prototype dialog which you 

can use to create new part or prototype definitions for your cars. The New button on the Car Part 

dialog invokes the Car Prototype dialog.  

Car Item Dialog  
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The dialog contains:  

Car Description which contains lists of Manufacturer, Prototype and Part Number which are used 

to select the Car Part. The Manufacturer list contains the entries Custom and Unknown for special 

Car Parts. For these entries you can enter the Part Number and Description fields.  

 If the manufacturer of your car is not listed in the Manufacturer list you can type in the new 

name. Also, if the Part is not listed you can enter a new part number. The new part will be 

added to the list of Custom Car Parts (Section 2.9.2).  

The Mode Radio button group lets you choose between the Information controls described here or the 

Customize controls described in the next section. You would use the Customize option to change Road 

name, Number or Color if you have repainted the car or to adjust the dimensions.  

Details about the individual car item such as Index, Price and Condition, Dates and Notes. The Index 

value must be unique for all car items.  

 To enter multiple New Cars you can set the Quantity field to a value greater than one. The 

Numbers Radio button group specifies whether the new car's numbers will be sequential (such 

as 1234, 1235, ...) or repeated.  

Message Line which will contain instructions if there any fields that need to be completed.  
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2.9.1.2 Car Part Dialog 

This dialog is similar the the Car Item dialog except that the Car Item Information section is not 

displayed. The Manufacturer Drop Down List is editable so you can enter a new manufacturer, and 

you must enter a Part Number. If you are adding a new car part, the Part Number field will be 

incremented (if it is a numeric value) so you can enter a number of car parts.  

 

The middle section contains:  

The Road, Reporting Mark, Number and Color. You can choose a Road name from the list 

of known road names or enter a new value. If known, the reporting mark (road name 

abbreviation) is filled in.  

Car Dimensions which contain the major dimensions of the car and how the coupler is 

mounted on the car. The Coupler Length is measured from the edge of the car body to the 

pulling face of the coupler. It is equivalent to half the separation between two coupled cars.  

 When entering values, the p key will convert a prototype measurement to a scale 

measurement.  

 The length dimension has the following relationship, so changing one value will affect 

the others:  



Coupled Length = Car Length + 2 * Coupler Length  
A diagram showing the position of the trucks and couplers.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2.9.1.3 Car Prototype Dialog 

This dialog is used to create or edit prototype definitions.  

 

The first section contains the name of the Prototype and its Type.  

If this dialog was invoked from the Car Item or Car Part dialog then the prototype diagram will be 

copied from the selected part. Otherwise, the prototype is drawn as the default image which is a simple 

blue rectangle or, if it is a locomotive, with one end angled.  

The Import button creates a prototype definition from the selected (Section 2.2.14) lines and shapes. 

To use this, first create a set of shapes (Filled Rectangles, Polygons, Circles, Lines etc) using the 

Draw (Section 2.3) commands on the main canvas. Select the shapes and use the Import button.  

The Reset button will reset the figure to the default image.  

If this dialog is invoked by the New button on the Car or Car Part dialog then the initial image will 

be copied from the prototype displayed on those dialogs. You can use this to make variations of 

existing prototypes.  
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The Color control on the Car Part dialog will replace any color of the Imported shapes which is not 

Black or a shade of gray with the selected hue.  

The Flip button flips the diagram horizontally. For locomotives, the forward direction is to the right.  

Unlike the other dialogs, dimensions in this dialog are in prototype units. When entering values, the s 

key will convert a scale measurement to a prototype measurement.  

 

2.9.2 Custom Management 

The Custom Management dialog allows you change the properties of turnouts, sectional track, 

structures, car parts and prototypes you have designed with the Turnout Designer (Section 2.9.8), 

Group (Section 2.9.3) or Car (Section 2.9.1.1) commands. You can also move selected objects to a 

Parameter File (Section 2.5.5).  

 

The Edit button invokes the appropriate designer or editor dialog for the selected item. This button is 

disabled if more than one (or no) object is selected.  

The Turnout Designer (Section 2.9.8) is used to modify the selected turnout design. If you wish to 

modify cosmetic details on a turnout or sectional track use the Group (Section 2.9.3) command to add 

them to an existing definition.  

Structures and old Turnout Designs use the Rename Dialog to change the Manufacturer, Description 

or Part Number values. For these objects the Edit button's label changes to Rename. Structures are 

not edited using this dialog but by using the Ungroup (Section 2.9.10) and Group (Section 2.9.3) 

commands.  

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdTurnoutNew.html#cmdTurnoutNew
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdGroup.html#cmdGroup
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdCarpart.html#cmdCarpart
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdPrmfile.html#cmdPrmfile
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdTurnoutNew.html#cmdTurnoutNew
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdGroup.html#cmdGroup
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdUngroup.html#cmdUngroup
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdGroup.html#cmdGroup


The Car (Section 2.9.1.1) dialog is used to modify Car Prototype and Car Parts.  

The Delete button removes the selected entries from the xtrkcad.cus (Section 1.8) file when you exit 

the dialog.  

The Move To button moves the selected entries to a Parameter File (Section 2.5.5). If the Parameter 

File does not currently exist than you will be prompted to supply a contents description line for the 

file. In case the parameter file already exists, the selected entries are appended to this file.  

The New buttons invokes the Car (Section 2.9.1.1) dialog to create a new Car Prototype or Car Part.  
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2.9.3 Group Dialog 

The Group command combines the selected (Section 2.2.14) Lines and Shapes (Section 2.3) to create 

structures (Section 2.7). You can give the structure (Section 2.7) a title consisting of Manufacturer, 

Description and Part Number on the Group dialog.  

 

The title will be pre-populated with the title of the last Structure you ungrouped (Section 2.9).  

You can include Turnouts, Sectional, Straight or Curved tracks in the selected objects which allows 

you to add cosmetic details to a Turnout definitions, or create a new Turnout definition. This can 

also be used to if there are fixed track locations on a structure, like on an engine shed.  

To modify a Structure or Turnout definition, first place the object on the layout, select and then 

Ungroup the object. Now the parts of the object can be edited using the Modify (Section 2.2.7), Draw 

(Section 2.3) or other commands. Once completed, select the object parts and use the Group 

command to update the definition (or create a new one by changing the title).  

The Group dialog shows the Manufacturer, Description and part number (Title) of the new definition. 

Initial values are based on selected turnouts and structures or on the last Ungrouped object (Section 

2.9.10). The dialog also contains a toggle button (Replace with new group?), which is used if you 

want to replace the selected objects with the new definition. All fields listed in this dialog window 

must contain data.  

The definition data will be added to the xtrkcad.cus (Section 1.8) file for later use. Please consider 

contributing this information for others to use.  

If you modify a definition from a XTrackCAD Library parameter file, the new definition will replace 

the existing definition on the Hot Bar (Section 2.7), otherwise it will be added to the end of the Hot 

Bar. You can use the Custom Management (Section 2.9.2) dialog to change the title or delete custom 

definitions.  

Note: There is a limit of 128 track segments in a group.  
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2.9.4 Layers Dialog 

Each object is contained in a layer. Objects which are created independently of other objects (such as 

straight tracks (Section 2.1.6) or text (Section 2.3.7)) are created in the current layer. Objects which 

are associated with other objects (such as tracks created by the Modify (Section 2.2.7) or Join 

(Section 2.2.6) commands) are created in the same layer as the associated object(s).  

The Layers dialog allows you to change various attributes of each of the 99 possible layers.  

Attributes associated with a layout are stored within the associated layout file and apply only to the 

layout that's open at the time of a change. It is possible to apply attributes from one layout file to 

another using the Load and Save buttons.  

 

The drop down list at the top of the dialog selects the Layer you are interested in. Non-empty layers 

are preceded by a +.  

The Name edit box contains the name of the Layer. This name is listed in the Current Layer drop 

down list on the Tool-bar (Section 3.1). Also the Name is displayed as the balloon help for the 

corresponding Layer Button.  

The Color button specifies the color of tracks if Color Layers (Section 2.10.3) radio button on the 

Display dialog is checked.  

The Visible check-box controls whether the Layer is drawn on the Main (Section 3.1) window.  

The Frozen check-box indicates that tracks in that Layer can not be modified or deleted.  

The On Map check-box controls whether the Layer is drawn on the Map (Section 3.2.2) window.  

You cannot uncheck Visible or check Frozen for the Current Layer.  
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The Count field displays the number of objects in the selected Layer.  

The Save button stores layer attributes in the xtrkcad.ini file so they may be loaded into an existing 

or new file. Once saved and unless reset to XTrackCAD Default, modified layer information is applied 

to each new file.  

The Load button reads layer attributes from the xtrkcad.ini file then applies it to each layer of the 

current layout file.  

The Defaults button restores layer attributes to default XTrackCAD settings.  

The bottom of the dialog contains the Number of Layer Buttons integer edit box. This controls the 

number of Layer Buttons displayed on the Tool-bar (Section 3.1). These buttons make it easy to 

switch between layers. The maximum number of Layer Buttons that can be displayed is 20. Therefore 

you should use layers one to twenty for objects which you will be showing and hiding frequently.  

 

The Layer Buttons on the Tool-bar (Section 3.1) control which layer is the current Layer and which 

Layers are displayed on the Main Canvas. These buttons are a short cut for the Visible check-box on 

the Layers dialog for the corresponding layer.  

The current layer is selected by picking a value from the drop down layer list. If the Layer you've 

selected was not visible, it will be shown.  

You can hide (or show if not visible) the different layers by pushing one of the Layer Buttons on the 

Tool-bar (if you have configured the tool-bar (Section 2.12.2) to show the Layer buttons). If a layer is 

not visible then the corresponding layer button will be raised. The active or current layer cannot be 

hidden.  

The color of each layer button shows the color that will be used to draw tracks in that layer, if you 

select Color Layers (Section 2.10.3) on the Display dialog.  

Any selected objects are unselected when the Layer is set to not visible. If a layer is not visible, you 

cannot select objects in the Layer. It is as if the objects do not exist until you show the layer again.  

The Move To Current Layer command on Edit menu (Section 2.4) will move all selected (Section 

2.2.14) tracks to the current Layer.  

Objects are drawn on the map window, if the Layer they are on has On Map checked.  
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2.9.5 Parts List 

The Parts List command produces a list of all selected (Section 2.2.14) turnouts, sectional track and 

bench-work. It also computes total length of selected flex-track.  

 

The Save As... button opens a File Save dialog window that's used to name and save the parts list to a 

file.  

The Print button opens the Print dialog which is used to facilitate printing of the parts list.  

The Close button terminates the Parts List command.  

The Parts List dialog will list pricing for selected objects if the Prices check box is checked. Prices 

are set using the Price List (Section 2.9.6) dialog.  

Hint: use the Parts List command to measure the length of selected flex-track.  
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2.9.6 Price List 

The Price List dialog allows entry of prices for Turnouts, Sectional Track and Structures. Only those 

objects from loaded Parameter Files (Section 2.5.5) or Custom Designs for the current Scale (Section 

2.10.6) are listed.  

 

The price of a selected object can be changed in the Cost edit box that's located above the "Price" 

column.  

The price of a length of Flex Track for the current Scale (Section 2.10.6) is listed at the bottom of the 

dialog. You can specify the Length in Inches or Centimeters. To specify the price for other Scales 

change Scale (Section 2.10.6) on the Layout (Section 2.10.6) window.  

The Parts List (Section 2.9.5) dialog lists prices for selected objects if the Prices check box on the 

dialog window is selected.  
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2.9.7 Train 

The Train command lets you place and run Trains on the layout.  

During this command, the Tool Bar and Hot Bar are changed. Most of the Tool Bar buttons are 

replaced by the Go/Stop and Exit buttons. The Go/Stop button toggles between Pausing all Trains and 

allowing Trains to Run. The Exit button terminates the Train Simulation and returns to Layout Design 

mode.  

 

Selecting New Cars  

The Hot Bar contains the Cars and Locomotives which are have not been placed on the Layout. 

Cars are created and managed using the Car Inventory (Section 2.9.1) dialog.  

Each item on the Hot Bar can represent a group of Cars. Cars can be grouped by Prototype, 

Manufacturer and/or Part Number. They can also be listed as individual Car Items. This 

grouping is controlled by Car Labels Drop Down List on the Display (Section 2.10.3) dialog.  

To place a Car, select it from the Hot Bar. If the Hot Bar is displaying Cars in groups (and not 

as individual Car Items) then a Drop Down List is displayed on the Status Bar (Section 3.1) 

containing the individual Car Items in that group.  

If you are not displaying the Hot Bar, then the New Car button ( ) will be shown on the 

Tool Bar. Pressing this button will display the Drop Down List on the Status Bar (Section 3.1) 

containing all of your Car Items that have not yet been placed on the layout.  
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Placing Cars  

Once you have selected a new Car, or have selected an existing Car on the Layout, you can 

position it by using the mouse to drag it around the Layout. If the Car is coupled to other Cars 

then the whole set of Cars is moved. If you place the Car on a Track, that Car (and the other 

coupled Cars) will be aligned along the track.  

Note: If you move the tracks but not the cars (or vice-versa) using the Move (Section 2.2.8) or 

Rotate (Section 2.2.13) commands the cars will not remain attached to the tracks. If the cars are 

moved close to a track, then they will be aligned when the Train Simulation command is next 

invoked.  

Coupling Cars  

If a Car is moved along a track to another Car then the Cars will be coupled together.  

Uncoupling Cars  

To uncouple Cars, Right-Click between the Cars then select Uncouple from the pop-up menu.  

 

Change Train or Car Orientation  

The orientation of a Train or Car can be reversed by Right-Click over the appropriate object 

then selecting either Flip Train or Flip Car from the pop-up menu.  

Remove Train or Car From Layout  

To remove a Train or Car from the layout, Right-Click over the appropriate object then select 

either Remove Train or Remove Car from the pop-up menu.  

Trains  

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdMove.html#cmdMove
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdRotate.html#cmdRotate


A Train consists of one or more Locomotives coupled to other Cars. One Locomotive will be 

the MU Master for the Train. The MU Master can be changed by Right-Clicking on a 

Locomotive and selecting MU Master from the pop-up menu. The MU Master is drawn with a 

solid Yellow head light indicating the direction is moving. If a Train is split by uncoupling 

between Locomotives, then two Trains will be created, each with their own MU Master.  

Train Control  

 

The Train Control dialog is used to set the speed and direction of Trains. The dialog contains a 

list of Trains (listed by their MU Master Locomotive). Before each Train on the list is either a 

Red circle (indicating the Train is stopped) or a Green circle (indicating the Train is moving).  

Any number of Trains can be running, although it might be difficult to keep track of more than 

a few.  

For the selected Train, the Train Control dialog lists  

Train status: indicating that the Train is moving, is paused or the reason if the Train is stopped.  

The position of the Train  

A slider which controls the speed of the Train in Scale Miles-Per-Hour or Kilometers-Per-

Hour.  

The Odometer which measures the total distance travelled by the train, which can be reset by 

pressing the 0 button.  



The Find button which positions the Main Window (Section 3.1) to show the Train. If the 

Trains on a track that's hidden and Hide Trains on Hidden Track (Section 2.10.3) is Enabled 

then the Train will be made visible until the next time it moves.  

The Follow toggle button which causes the Main Window (Section 3.1) to follow the Train as 

it moves. The Follow toggle can only be set on one Train at a time, and it is cleared if you 

press the Find button or otherwise manually move the main canvas.  

The Auto Reverse toggle button which causes the Train to change direction when it hits the end 

of a track.  

The Direction radio button group which controls the direction (Forward or Reverse) of the 

Train.  

The Stop button which sets the Trains speed to 0.  

Train Operation  

Once a Train is moving, it will continue to move until it is Stopped manually, hits the end of 

track or an open Turnout. If the Train 'runs into' other Cars, those Cars will be coupled to the 

Train. If Trains speed is faster than the Max Coupling Speed (Section 2.10.7) then the Train 

will crash and must be manually moved back onto the track.  

If two Trains are coupled, one of the two MU Masters will be chosen as the MU Master for the 

combined Train.  

The motion of all Trains can be Paused by clicking the Go/Stop button on the Main Window 

Tool Bar. Pressing the Escape key has the same effect as clicking on the Stop button. This 

allows you set Turnout positions or make other changes. When Train command starts, the 

Go/Stop button is in the Stop position and must be clicked before Trains move.  

Turnouts and Turntables  

Turnout positions are indicated by Red lines connecting the endpoints on the route through the 

Turnout. Trains will follow this route through the Turnout. If you Shift+Left-Click on the 

Turnout, the next position will used and Red line changed to indicate the new position.  

Turntables can be turned by using Shift+Left-Click on the endpoint you want the Turntable to 

move to. To turn the Turntable 180°, Shift+Left-Click on the endpoint again.  
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2.9.8 Turnout Designer 

The Turnout Designer allows you to define new turnouts and sectional track pieces.  

 

The Turnout Designer sub-menu is pictured above. As demonstrated by the sub-menu a number of 

different dialogs are available for creation of custom turnout and sectional track components. New 

turnouts and sectional track is added to Custom Management (Section 2.9.2) and Turnout Manager 

(Section 2.1.8) using the Turnout Designer.  

The follow dialog is for a regular turnout.  

 

Each dialog shows a diagram of the turnout and has fields to enter dimensions. The dimensions should 

be as accurate as possible. The various types of dimensions are:  

Length - measured from the base of the turnout to the centerline at the end of the turnout. 

Length is measured parallel to the centerline of the straight leg of the turnout. For track that 
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ends on a curve (such as the curved leg of a regular turnout) measure the distance from the 

base to each rail and average the values.  

Offset - measured from the centerline of the straight leg of the turnout to the centerline of the 

track at the end of the turnout.  

Angle - angle at the end of turnout to the centerline of the straight leg of the turnout. This angle 

may not be the same as the Frog angle of the turnout if the rails curve past the Frog. The Frog 

Number|Degrees Radio button group controls whether the value is expressed in Frog Number 

or Degrees.  

Manufacturer - name of the Manufacturer  

Description - description of the turnout including size and rail code number, e.g., 'Left Hand 

#4'. This information is shown when a place the mouse pointer over the respective symbol on 

th Tool-bar. Therefor it should be made sure that the data entered here are helpful in finding 

the correct turnout.  

# - part number, e.g., '999-123'.  

Roadbed Width - if greater than the track gauge then lines are drawn along the edges of the 

turnout to represent the attached roadbed available on some types of sectional track and 

turnouts.  

Line Width - the width of the roadbed lines, measured in pixels when the layout drawing scale 

(Section 2.12) is 1:1.  

Color - color of the roadbed lines.  

The rail height (Code) can be added to the Manufacturer, e.g., Peco-55, or the Description, e.g., 

Medium Right, Code 55.  

The scale is the current scale from the Scale Drop Down List on the Layout dialog (Section 2.10.6).  

Manufacturer, Description and Part Number (#) comprise the title of the turnout. These values are 

used in the Turnout Selection dialog (Section 2.1.8) and the Parts List (Section 2.9.5). For regular 

and curved turnouts there are separate Descriptions and Part Numbers for the right and left hand 

turnouts.  

The Print button prints a full size diagram of the turnout. You can use this to check your dimensions 

and make any required changes. You should expect to make several printouts as you refine your 

dimensions.  

The OK button completes the design. The new turnout is added to the list in the Turnout Selection 

dialog. The turnout data is saved in the xtrkcad.cus (Section 1.8) file for the next time you use 

XTrackCAD. Please consider contributing this information for others to use via the on-line addresses. 
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You can change the Parameters or Title of existing designs by using the Custom Management 

(Section 2.9.2) dialog.  

The Cancel button removes the Turnout Designer dialog.  

Creating Turnout Designs  

 It is best to start by marking the endpoints of the turnout on a piece of paper. Extend the curved 

leg of the turnout (try attaching a straight sectional track) and measure the angle. Frog numbers 

are easiest to calculate.  

 Enter your data and press Print, if you have an accurate printer. Check the dimensions of the 

turnout against the printout and make adjustments as necessary. Concentrate on the lengths and 

offsets first, then adjust the angles.  

 The resulting turnout is an approximation. In particular the curves will not be correct, but this 

is not important for placing turnouts.  

 The Group (Section 2.9.3) command can be used to add cosmetic details to Turnout 

definitions.  
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2.9.9 Update Turnouts and Structures 

This command updates (or refreshes) selected turnouts, sectional tracks and structures on your layout 

with the current definitions from the loaded parameter files (Section 2.5.5). Each selected object that is 

found in a parameter file is updated with the current definition.  

If an object can not be found or if the new definition does not fit (same number of endpoints and all 

the endpoints have the same position and angle) then a dialog is displayed which contains suitable 

definitions that you can choose from. You can Skip the current object or Cancel to skip all the 

remaining objects.  

If an object has been updated then it is unselected, otherwise it will remain selected at the end of this 

command.  
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2.9.10 Ungroup 

Ungroup allows existing definitions to be modified and the resulting objects recombined with the 

Group (Section 2.9.3) command to update the definition. Turnouts are composed of individual 

straight and curved segments. Segments that form the points (Section B.2) of the turnout remain 

combined as an Ungrouped Turnout, and the other segments are replaced by straight and curved 

tracks.  
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2.10 Options Menu 

 

The Options Menu shows commands to change configuration options.  

Colors - Displays the Colors (Section 2.10.1) dialog.  

Command - Displays the Command Options (Section 2.10.2) dialog.  

Display - Displays the Display (Section 2.10.3) dialog.  

Easement - Displays the easement (Section 2.10.4) dialog which controls how easements (spiral 

transition curves) are used to join tracks.  

Fonts - Displays the font selection (Section 2.10.5) dialog which selects the font used by the text 

(Section 2.3.7) command. This command is only available on UNIX based systems.  

Layout - Displays the layout (Section 2.10.6) dialog.  

Preferences - Displays the Preferences (Section 2.10.7) dialog.  

Sticky - Displays the Sticky Commands (Section 2.10.8) dialog.  
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2.10.1 Colors Dialog 

The Colors dialog is invoked from the Options (Section 2.10) menu  

 

The Colors dialog controls the color that various objects are drawn.  

Border - Sets color of Rulers, Room Boundaries and Table Edges.  

Exception Track - Sets color of Exceptional Tracks (Section 2.10.6). Those which exceed the specified grade or 

are have a radius smaller than the minimum set.  

Marker - Sets color of short lines drawn on the Ruler of the Main (Section 3.1) window to indicate cursor 

position.  

Normal Tracks - Sets color of normal track.  

Primary Axis - Sets color of the large cross displayed when positioning the Snap Grid (Section 2.12.1) or the 

Print Grid (Section 2.5.6).  

Profile Path - color of the path when using the Profile (Section 2.2.10) command.  

Secondary Axis - Sets color of the large cross displayed when positioning the Snap Grid (Section 2.12.1) or the 

Print Grid (Section 2.5.6).  

Selected Tracks - Sets color of Selected track.  

Snap Grid - the Grid displayed by the Snap Grid (Section 2.12.1) dialog.  

Track Ties - color of ties (if drawn).  
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2.10.2 Command Option Dialog 

The Command Option dialog is invoked from the Options (Section 2.10) menu  

 

The Command Option dialog contains items which control the behavior of some commands.  

Draw Moving Tracks - how to draw tracks during move and rotate operations. See Section 2.2.14 and 

Section 2.2.8 for additional detail.  

Default Command - selects the Properties (Section 2.2.11) or Select (Section 2.2.14) as the default 

command which is invoked when any other command (if not Sticky (Section 2.10.8)) is canceled or 

completed.  

Right-Click - will either display a pop-up menu of available commands or command-specific options 

depending on whether the Shift key is being held down or not. This option allows you to choose which 

operation occurs.  
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2.10.3 Display Dialog 

The Display dialog is invoked from the Options (Section 2.10) menu  

 

The Display dialog contains items which control the display of objects on the Main window.  

Auto Pan - if enabled, dragging near the edge of the Main Canvas (Section 3.1) will cause the canvas to 

move to follow the mouse.  

Car Labels - controls the grouping and display of Cars on the Hot Bar (Section 2.7) during the Train 

(Section 2.9.7) command. This can be a combination of Prototype, Manufacturer, Part Number and 

Item.  

Color Layers - when set, tracks and/or non-tracks (lines, table edges and structures) are drawn with 

color of the layer (Section 2.9.4) they belong to.  
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Draw EndPts - when to draw endpoints between connected track: never, only for turnouts or for all 

tracks.  

Draw Ties - how to draw ties under the rails when the drawing Scale is smaller than half of the Two 

Rail Scale.  

Draw Tunnel - how to draw hidden tracks (Section 2.4.4), either not at all, as dashed lines or as normal 

solid lines (which might be faster).  

Hide Trains On Hidden Track - controls whether trains (Section 2.9.7) on invisible layers (Section 2.9.4) 

or hidden tracks (Section 2.4.4) (if hidden tracks are not drawn) are displayed.  

Hot Bar Labels - controls the format of titles for objects on the Hot Bar (Section 2.7).  

Label Enable - individual control over whether to display various types of labels. You may want to turn 

some of these off if your layout is too cluttered.  

 Cars - Reporting mark labels on cars.  
 EndPt Elevations - Elevation markers attached to endpoints.  
 Lengths - Length of flex-track attached to ends of turnouts.  
 Track Descriptions - Title of each turnout and sectional track.  
 Track Elevations - Computed elevations at the center of each track.  

Label Font Size - controls font size for Labels on layout.  

Layout Labels - controls the format of titles for turnouts and structures displayed on the Layout.  

Label Scale - draw labels only when the drawing Scale is smaller or equal to this value.  

List Labels - controls the format of titles for turnouts and structures displayed in lists (such as the 

Parts List (Section 2.9.5)).  

Live Map - if checked then the Main Window (Section 3.1) will be updated as you drag on the Map 

Window (Section 3.2.2). Note that this can be slow.  

Map Scale - scale of the Map (Section 3.2.2) window. Increase this value to make the Map window 

smaller when working with large layouts. Note: you cannot make the Map window larger than the 

screen.  

Train Update Delay - number of milliseconds between updates in the Train Simulation (Section 2.9.7) 

mode. A lower value will generate a smoother display but reduces system responsiveness.  

Two Rail Scale - draw tracks using two lines when the drawing Scale is smaller than this value.  
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2.10.4 Easements 

Easements are special sections of gradually curving track used to connect straight and curved tracks 

(or two curved tracks). Easements reduce the effects of sudden changes in track curves which can 

cause jerky motion and derailments.  

Easements can be created every time you Join (Section 2.2.6) tracks, Extend (Section 2.2.7.4) a track 

or create a Tangent (Section 2.2.7.2) track.  

When using easements, an error message will be generated if tracks have a radius that is too small or 

are too short for the transition curve.  

The Easement dialog is invoked from the Options (Section 2.10) menu.  

 

Value - allows fine tuning of the easement parameters (restricted to values >= 0.5).  

R - minimum radius of the curved track.  

X - offset between a straight and curved track.  

L - length of the transition track.  

Radio button group with None, Sharp, Normal and Broad. Corresponding Values for these buttons are 

0, 0.5, 1.0 and 2.0. Select None to turn easements off.  

The values R, X and L are read-only.  

These values indicate the worst case of joining a straight track with a curve of radius R. The two 

tracks are separated by the offset X while the easement curve extends for L/2 inches or centimeters to 

each side of the endpoints.  

The formula used to draw easements is:  

         x = l * l * l / (6 * R * L) 

         r = L * R/l 

where  
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 l is the distance along the tangent to the easement.  
 R is the final radius of the easement.  
 L is the total length of the easement along the tangent.  
 x is the offset from the tangent at l.  
 r is the radius of easement curve at l.  

The Easement Button ( ) on the Main Window (Section 3.1) changes its label to indicate the 

current easement value.  

The following diagrams illustrates the R, X and L values and the resulting easement curve.  

 

 

If curves with a radius larger than R or two curves (that bend in the same direction) are being 

connecting then the easement curve will be shorter and the offset smaller. If the computed offset is 

small then no easement is generated.  

A curved track that bends in one direction and then bends in the opposite direction is an S-curve. This 

will generate the worst case easement which is two easement curves placed end to end.  
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Refer to instruction in section 2.10.4.1 when using sectional track.  
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2.10.4.1 Easements and Sectional Track 

Easements require the possibility of creating track with arbitrary radii. Therefore easements are not 

possible if sectional track is used. It is best to turn Easements off when using sectional track.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



2.10.5 Font Selection 

The font selection dialog allows selection of the font used by the text (Section 2.3.7) command. This 

command is valid only on UNIX based systems.  
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2.10.6 Layout Dialog 

The Layout Options dialog, displayed by the Options (Section 2.10) menu, contains items controlling 

the current layout.  

 

Gauge - Drop down menu used to select track gauge.  

Height - Height of layout drawing which, depending on the Unit setting (English or Metric) established 

in the Preferences dialog (Section 2.10.7), is measured in inches or centimeters.  

Room Width - Width of layout drawing which, depending on the Unit setting (English or Metric) 

established in the Preferences dialog (Section 2.10.7), is measured in inches or centimeters.  

Scale - Drop down menu used to select track scale.  

Title - Two lines that can be used to enter title and subtitle descriptions for the layout. Information 

entered in these fields will be shown on any printout of your layout design.  

Maximum Track Grade - Specifies maximum track elevation expressed as a percent (%). Tracks with 

a larger elevation are considered exceptional and drawn in the exception (Section 2.10.1) color.  

Minimum Track Radius - Specifies minimum track radius (in inches or centimeters). Curved tracks 

with a smaller radius are considered exceptional and drawn in the exception (Section 2.10.1) color.  
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2.10.7 Preferences Dialog 

This dialog controls some parameters which likely will not be changed frequently.  

 

Angles - controls the angle system. Polar: 0° is up and angles are measured clockwise, or Cartesian: 

0° is to the right and angles are measured counter-clockwise.  

Balloon Help - disables the display of Balloon Help (Section B.1) which usually is shown when the 

cursor is placed over a control.  

Check Point - specifies the Check Point frequency; the number of modifications made to the layout 

since the last save. The layout is automatically saved to the Check Point file (Section 1.8.3) when the 

Check Point frequency is reached. Setting this value to 0 disables use of the Checkpoint file.  

Connection Angle - as above for the angle between endpoints.  

Connection Distance - the maximum distance between endpoints that can be connected. This affects 

the Join (Section 2.2.6) command and auto-connection during Parallel (Section 2.1.5) commands and 

placing Turnouts (Section 2.7). The default value for this field is 0.100 inches or 0.254 CM. Changing 

this value is not recommended.  

Drag Distance - controls how far you can move the cursor (in pixels) before XTrackCAD considers the 

action to be a drag instead of a click.  
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Drag Timeout - controls how long you can hold a mouse button down (in milliseconds) before 

XTrackCAD considers the action to be a drag instead of a click.  

Length Format - controls how lengths are displayed. Combinations of feet and inches (or meters, 

centimeters and millimeters) with support for decimal or fractional measures. Note: lengths can be 

entered in any format and are converted on entry.  

Max Coupling Speed - trains (Section 2.9.7) moving faster than this speed will crash when running 

into other trains or hitting the end of a track or an open turnout. Crashed trains must be manually moved 

back onto the track.  

Min Grid Spacing - minimum distance between Grid (Section 2.12.1) lines (in pixels). If the grid lines 

are closer then drawing them is suppressed.  

Min Track Length - specifies the minimum length of a track. Shorter tracks will not be created.  

On Program Startup - if set to ‘Load Last Layout’, XTrackCAD will automatically re-open the layout 

file that was open when XTrackCAD last closed. Selecting ‘Start New Layout’ opens a blank layout 

canvas.  

Turntable Angle - minimum angle between adjacent tracks connected to a Turntable (Section 2.1.9).  

Units - choose between English (inches) or Metric (centimeters) measurements.  
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2.10.8 Sticky Dialog 

By default, when commands complete, the defined Default Command (Section 2.10.2) becomes 

active. If a command is sticky, the defined Default Command is ignored and the current command 

remains active after completion.  

The Sticky dialog controls which commands remain active after completion.  

 

Selecting a command makes it sticky. Un-selecting a command causes the defined Default Command 

to become active after command completion.  
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2.11 Status Bar 

The Status Bar contains:  

The Line Width and Color for Straight Line, Curved Line, Circle, Box or Poly Line objects. The Line 

Width is specified in pixels for the current Drawing Scale. Zooming (Section 2.12) in or out causes the 

lines to be drawn wider or narrower.  

The Color for Filled Circles or Polygons.  

The size of a Dimension Line (Tiny, Small, Medium or Large)  

The type, size and orientation of lumber used for Bench-work (regular rectangular, L-Girder or T-

Girder).  

If the Ctrl key is held down while creating or modifying lines and shapes then the cursor will be 

attracted to other objects.  
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2.12 View Menu 

 

The View Menu shows commands affecting the display of the Main Canvas (Section 3.1).  

Change Grid - Displays the Snap Grid dialog. The Snap Grid forces the cursor (for some commands) to 

be on a grid to control track placement.  

Enable SnapGrid - Enables (or disables) the Snap Grid (Section 2.12.1).  

Redraw - Redraws the Main Canvas.  

Redraw All - Redraws the Main Canvas and the Map Window (Section 3.2.2).  

Show Snap-Grid - Toggles display of the Snap Grid on and off.  

Tool-bar - Command button groups displayed on the Tool-bar are selected using the Tool-bar 

Configuration Menu (Section 2.12.2).  

 

Zoom - This sub-menu is used to select a specific drawing scale ratio for the Main Canvas.  

Zoom In - Increases magnification of the Main Canvas.  

Zoom Out - Decreases magnification of the Main Canvas.  

When zooming in or out, the corresponding highlighted area of the Map Window (Section 3.2.2) 

changes size to match that which appears on the Main Canvas (Section 3.1).  
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2.12.1 Grid Dialog 

The Grid dialog, displayed by Change Grid on the View (Section 2.12) menu, specifies the origin, 

angle and other parameters of the Snap Grid. The Snap Grid controls the position of the cursor during 

the Curve (Section 2.1.2), Circle (Section 2.1.1), Modify (Section 2.2.7), Straight (Section 2.1.6), 

Line Drawing (Section 2.3) and Turntable (Section 2.1.9) commands.  

 

The Grid dialog contains controls affecting the horizontal and vertical snap grid lines. Each dimension 

can be independently controlled.  

The Spacing value specifies the distance between major grid lines, which are drawn as solid lines on 

the layout.  

The Divisions value adds the minor Grid lines between the major Grid lines, which are drawn as a 

series of dots on the layout. Specifying a value of 0 or 1 as the division value removes the minor grid 

lines.  

The Grid can be enabled or disabled in each dimension via the Enable check box.  

The X and Y coordinates relate to the anchor point of the X and Y Axis. Default values for X and Y are 

zero (0). Entering a value of one for X causes the Main grid line on the Drawing Canvas to shift left one 

unit. Entering a value of two causes the Main grid line to shift by two units and so on. The Y axis is 

affected in the similar manner except the grid moves down rather than left.  

Negative values can be used for X and Y values. Using such cause the Main Grid to shift right for the X 

Axis and up for the Y Axis.  

The A coordinate relates to the Angle of grid rotation. The default value for this coordinate is zero. 

Entering a value greater than 0 and less than 90 will cause the Main Grid to rotate clockwise by the 

number of degrees entered. Entering a negative value causes the grid to rotate counter-clockwise.  

The origin and angle of the Grid can be adjusted directly or by dragging on the layout. Left+Drag 

moves the origin of the Grid, and Right+Drag rotates the grid. Shift+Right-Click (Section 3.4) 

displays a pop-up menu allowing rotation of the grid by various predefined angles.  
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Whether the Snap Grid is drawn is controlled by the Show check-box. Also, if the layout is Zoomed 

Out (Section 2.12.3) the minor and major grid lines may be too close together to be drawn. The 

minimum pixel distance between grid lines is controlled by the Min Grid Spacing value on the 

Preferences (Section 2.10.7) dialog.  

Note: on slow machines drawing the Grid can take noticeable time. Performance can be improved by 

selecting a larger value for Min Grid Spacing.  

Grid Buttons on the Tool-bar (Section 3.1) can be used to Enable/Disable and to Show/Hide 

the Snap Grid.  
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2.12.2 Tool-bar Configuration 

 

Command button groups displayed on the Tool-bar are selected using the Tool-bar Configuration 

Menu (Section 2.12.2). If none of the command button groups are selected, the Tool-bar is not shown.  
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2.12.3 Zoom 

 

The Zoom In and Zoom Out actions can also be accessed using buttons on the Tool Bar. The Mouse 

Wheel, PAGE DOWN and PAGE UP keys can also be used to zoom in and out.  

Holding down the Shift key while clicking the Zoom In or Zoom Out buttons sets the Drawing Scale 

to a Programmed Zoom value.  

Programmed Zoom  

 The Programmed Zoom value for the Zoom In button is set to the current Drawing 

Scale by holding down the Shift and Ctrl keys while clicking on the Zoom In button.  

 The Programmed Zoom value for the Zoom Out button is set to the current Drawing 

Scale by holding down the Shift and Ctrl keys while clicking on the Zoom Out button.  

Normally a zoom in more of more than 1:1 is not possible, however if the Ctrl key is held down while 

the Zoom In button is pressed a zoom less that 1:1 can be achieved. This function is useful when 

working on detail.  

Pressing the middle Zoom button on the Tool Bar pop-ups a list of Zoom factors that can be select 

from.  

 

 

 

 

 

 

 



2.13 Window Menu 

 

The Window Menu typically contains selections for bringing any open window into view. It's used as 

follows;  

XTrackCAD permits multiple dialog windows to be open at any one time. When a large number of 

windows are open it can become difficult to locate and bring a specific window into focus. Use the 

Window Menu function to select and bring the desired window to the top of the screen.  

 

Apart from bringing the Map Window (Section 3.2.2) to the foreground, the Map menu item can also 

be used to re-opened a closed Map Window.  
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Chapter 3: Navigation 

The Main Window includes a title bar along the top that describes the contents of the window, 

followed by a tool bar that contains user interface buttons. Most of the window's remaining area is 

used to display the layout.  

Most windows can be opened, closed, resized, minimized, and moved around the screen. The close, 

minimize, and zoom buttons are located on the right side of the title bar. Minimizing a window will 

close the contents of the window, but store a reference to it in the Task bar. Closing a window will 

make it disappear completely (so you may be asked to save your changes first). To move a window, 

click on the title bar and drag the window where you want it. To resize a window, either click the 

Zoom button  

 

 

 

 

 

 

 

 

 

 

 



3.1 Main Window Overview 

Main Window Overview  

 

The size of the main window can be changed by dragging on the resizing borders.  

Minimizing the Main Window will minimize all XTrackCAD windows.  

The Main Window contains (from the top down):  

Title bar  

 

Current filename, XTrackCAD version number, and window manager buttons. An asterisk (*) after the 

filename indicates that there are unsaved changes.  

Menu Bar  

 

Contains from left to right;  



 File (Section 2.5)  
 Edit (Section 2.4)  
 View (Section 2.12)  
 Add (Section 2.1)  
 Change (Section 2.2)  
 Draw (Section 2.3)  
 Manage (Section 2.9)  
 Options (Section 2.10)  
 Macro (Section 2.8)  
 Window (Section 2.13) and;  
 Help (Section 2.6) menu buttons.  

Tool Bar  

 

Manipulate track and other objects  

Hot Bar (Section 2.7)  

 

Scrolling list of Turnouts and Structures  
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Main Canvas  

 

Main drawing area with rulers along each side.  

The Main Canvas is where all tracks and objects are drawn.  

The scale of the Main Canvas can be changed using the;  

 Zoom selections (Section 2.12.3) under the View (Section 2.12) menu  
 Zoom buttons on the Tool-bar  
 Mouse Wheel  
 PAGE UP and PAGE DOWN keys.  

Tracks will be drawn with two lines and ties if you zoom in. When the drawing scale is 1:1 a dashed 

centerline is also drawn for each track.  

The ARROW keys move the Canvas left, right, up or down.  
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Map Window  

 

You can change which portion of the layout is displayed by using the Map Window (Section 3.2.2).  

Status Bar  

 

Contains from left to right;  

 Drawing scale of the Main Canvas,  
 X position of the cursor,  
 Y position of the cursor,  
 Status and informational messages  

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdMap.html#cmdMap


3.2 General Operation  

Most Windows open with three standard dialog buttons:  

Cancel - Cancels dialog. Layout reverts back to its previous state.  

Help - Invokes on-line help for current command or dialog.  

OK - Completes the dialog action. Layout is updated with current changes.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 



3.2.1 Entering Values 

Lengths and Distances can be entered in a variety of formats;  

12ft 4 1/2in, 12' 4.5", 148.500, 1.234m, 123.4cm or 1234mm are all valid values.  

Pressing the Equal Sign (=) key after an entry will reformat the value entered to your preferred length 

format (Section 2.10.7).  

Pressing the "p" key after an entry will convert a prototype measurement to a scale measurement by 

dividing the value entered by the ratio for the current scale.  

Pressing the "s" key after an entry will convert a scale measurement to a prototype measurement.  
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3.2.2 Map Window 

 

The Map Window area shows the complete layout at a reduced scale. A highlighted (reverse video) 

area shows what portion is visible in the Main Window (Section 3.1). The highlighted area can be 

Left+Dragged (Section B.1) around the layout to change the origin of the Main Canvas. The 

highlighted area changes size as Zoom In (Section 2.12) and Zoom Out (Section 2.12) are selected.  

You can also Right+Drag (Section B.1) on the Map window to set the origin and scale of the Main 

Canvas.  

The size of the Map Window changes when you change the Room Size (see Section 2.10.6). You can 

also change the Map Scale (Section 2.10.3) on the Display (Section 2.10.3) dialog to change the size 

of the Map Window.  

If you close the Map Window, you can reopen it by the Window menu.  
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3.3 Keyboard Shortcuts  

The term Shortcut key refers to specific key combinations which are used to accomplish an action 

which otherwise would be accomplished by moving a MOUSE and /or selecting from a Menu. 

Shortcut keys are often key combinations consisting of the letter key pressed along with the Alt or Ctrl 

key.  

Instead of using the menus or the buttons on the Tool-bar (Section 3.1), most XTrackCAD commands 

may be invoked through use of Shortcut keys.  

The RETURN key has the same effect as pressing the OK button on the current dialog.  

The ESCAPE key cancels the current command. All selected tracks are unselected. The Properties 

(Section 2.2.11) or Select (Section 2.2.14) command becomes the current command.  

The PAGE UP and PAGE DOWN keys will zoom out or zoom in.  

The ARROWS key will pan the canvas right, left, up and down.  

The DELETE key invokes the Delete (Section 2.4.3) command.  

Several Shortcut key commands are used in conjunction with the mouse. These commands are listed in 

Section 3.4.  
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3.3.1 Add Commands 

Add Commands  

Create  

 Circle track from  

o center - Ctrl+0  

o fixed radius circle - Ctrl+8  

o tangent - Ctrl+9  

 Curve track from  

o center - Ctrl+6  

o chord - Ctrl+7  

o endpoint - Ctrl+4  

o tangent - Ctrl+5  

 Hand laid turnout - Ctrl+Shift+I  

 Straight track - Ctrl+G  

 Turntable - Ctrl+Shift+N  

Helix dialog and construction tool - Ctrl+Shift+H  

Structure dialog - Ctrl+Shift+C  

Turnout dialog - Ctrl+T  

 

 

 

 

 

 

 

 

 



3.3.2 Change Commands 

Change Commands  

Connect two sectional tracks - Ctrl+Shift+J  

Elevation dialog - Ctrl+Shift+E  

Join two tracks - Ctrl+J  

Properties dialog - Ctrl+?  

Modify or extend track - Ctrl+M  

Move  

 description - Ctrl+Shift+Z  

 selected object - Ctrl+Shift+M  

Profile dialog - Ctrl+Shift+F  

Rotate selected object - Ctrl+Shift+R  

Select tool - Ctrl+E  

Split flex track - Ctrl+Shift+S  

 

 

 

 

 

 

 

 

 

 



3.3.3 Draw Commands 

3.3.3.1 Add Text 

Add Text  

Add Text to drawing area - Ctrl+Shift+X  

 

 

 

 

 

 

 

 

 

 

 

 

 



3.3.3.2 Draw Circles 

Draw Circles  

Draw circle outline from  

 center to tangent point (Edge) - Ctrl+Shift+0  

 tangent point (Edge) to center - Ctrl+Shift+9  

Draw circle filled from  

 center to tangent point (Edge) - Ctrl+Alt+0  

 tangent point (Edge) to center - Ctrl+Alt+9  

 

 

 

 

 

 

 

 

 

 

 



3.3.3.3 Draw Curved Lines 

Draw Curved Lines  

Draw curved lines from;  

 center to endpoint - Ctrl+Shift+6  

 chord - Ctrl+Shift+7  

 endpoint in direction of curve - Ctrl+Shift+4  

 endpoint to center - Ctrl+Shift+5  

 

 

 

 

 

 

 

 

 

 

 

 



3.3.3.4 Draw Shapes 

Draw Shapes  

Draw shape  

 Box outline - Ctrl+Shift+[  

 Filled Box - Ctrl+Alt+[  

 Filled Polygon - Ctrl+Alt+2  

 Poly-line - Ctrl+Shift+2  

 

 

 

 

 

 

 

 

 

 

 

 



3.3.3.5 Draw Straight Objects 

Draw Straight Objects  

Draw straight object  

 Bench-work - Ctrl+B  

 Dimension Line - Ctrl+Shift+D  

 Straight Line - Ctrl+Shift+1  

 Table Edge - Ctrl+Shift+)  

 

 

 

 

 

 

 

 

 

 

 

 



3.3.3.6 Note Dialog 

Note Dialog  

Note dialog (Section 2.3.3) - Ctrl+Alt+N  
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3.3.4 Edit Commands 

Edit Commands  

Copy select objects to the clipboard - Ctrl+C or Ctrl+Insert  

Cut select objects - Ctrl+X or Shift+Delete  

Draw selected tracks with  

 thin lines - Ctrl+1  

 medium lines - Ctrl+2  

 thick lines - Ctrl+3  

Delete selected object(s) - Delete or Ctrl+D  

Deselect all objects - Alt+Shift+A or Esc  

Hide selected tracks in a Tunnel - Ctrl+Shift+T  

Move Selected tracks  

 above others - Ctrl+Shift+B  

 below others - Ctrl+Shift+W  

Paste from clipboard to layout - Ctrl+V or Shift+Insert  

Redo last undone command - Ctrl+R  

Select all objects - Ctrl+Shift+A  

Undo last command - Ctrl+Z or Shift+Backspace  

 

 

 

 

 

 

 

 



3.3.5 File Commands 

File Commands  

Create a new layout - Ctrl+N  

Edit layout description Note (Section 2.3.3) - Ctrl+Alt+T  

Export  

 Selected objects to a .xti file - Ctrl+Alt+X  
 To Bitmap (Section 2.5.2) - Ctrl+Shift+Q  

Import from a .xti file - Ctrl+Alt+I  

Manipulate Parameter Files (Section 2.5.5) - Ctrl+Alt+S  

Open layout file - Ctrl+O  

Print Command (Section 2.5.6) - Ctrl+P  

Save As another file - Ctrl+A  

Save the current layout - Ctrl+S  
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3.3.6 Hot Bar 

Hot Bar  

These actions take effect if the Hot Bar has keyboard focus.  

 Move Hot Bar multiple entries  

o left - Shift+Left Arrow  

o right - Shift+Right Arrow  

 Move Hot Bar one entry  

o left - Left Arrow  

o right - Right Arrow  

 Pop-up menu of Hot Bar contents - Right-Click  

 Set relative position of Hot Bar - 1, 2 ... 9, 0  

 

 

 

 

 

 

 

 

 

 



3.3.7 Macro Commands 

Macro Commands  

Play Back a macro file (Section 2.8) - Ctrl+Alt+B  

Record a macro file (Section 2.8) - Ctrl+Alt+R  
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3.3.8 Main Drawing Canvas 

Main Drawing Canvas  

These actions take effect if the Main Drawing Canvas has keyboard focus.  

Move Canvas:  

 Down - Down Arrow  

 Left - Left Arrow  

 Right - Right Arrow  

 Up - Up Arrow  

 

 

 

 

 

 

 

 

 

 

 

 



3.3.9 Manage Commands 

Manage Commands  

Car Inventory dialog - Ctrl+Alt+V  

Custom Management dialog (Section 2.9.2) - Ctrl+Alt+U  

Generate a Parts List (Section 2.9.5) - Ctrl+Alt+L  

Group objects (Section 2.9.3) - Ctrl+Shift+G  

Layers dialog (Section 2.9.4) - Ctrl+Alt+Y  

Ungroup objects (Section 2.9.3) - Ctrl+Shift+U  

Update Prices (Section 2.9.6) - Ctrl+Alt+Q  
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3.3.10 Option Commands 

Options Commands  

Colors dialog (Section 2.10.1) - Ctrl+Alt+C  

Command Options dialog (Section 2.10.2) - Ctrl+Alt+M  

Display dialog (Section 2.10.3) - Ctrl+Alt+D  

Easement Options dialog - Ctrl+Alt+E  

Font dialog (Section 2.10.5) - Ctrl+Alt+F  

Layout dialog (Section 2.10.6) - Ctrl+Alt+A  

Preferences dialog (Section 2.10.7) - Ctrl+Alt+P  

Sticky commands dialog (Section 2.10.8) - Ctrl+Alt+K  
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3.3.11 View Commands 

View Commands  

Redraw  

 all - Ctrl+Shift+L  
 main window - Ctrl+L  

Snap Grid dialog (Section 2.12.1) - Ctrl+Alt+G  

Zoom  

 in - Ctrl++, Page Down  
 out - Ctrl+-, Page Up  

 

 

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/cmdGrid.html#cmdGrid


3.4 Mouse Actions 

XTrackCAD uses the left and right mouse buttons when manipulating tracks and other objects on the 

layout. Their meaning depends on the particular command but in general:  

Left-Click - selects an object or an endpoint.  

Left+Drag - modifies an object, such as extending it.  

Right-Click - displays a pop-up menu of commands.  

Shift+Right-Click - displays a pop-up menu of command options (for some commands).  

Rotate Wheel - zooms drawing area in and out.  

When Moving and Rotating ( Placing Turnouts and Structures, Moving the Print and Snap Grids, ... ):  

(Left+Drag) - moves the objects or grid.  

(Right+Drag) - rotates the objects or grid about the pivot point, which is the point you started 

the drag operation.  

Some commands use the Shift or Ctrl key to modify the meaning of button presses.  

 

3.4.1 Context Sensitive Menus 

For all commands listed below, a Right-Click will display a context sensitive pop-up command list 

menu. For some commands (noted below), a Shift+Right-Click will display a context sensitive pop-up 

command options menu. The operation of Right-Click and Shift+Right-Click can be reversed by an 

item on the Command Options (Section 2.10.2) dialog.  

The Shortcut key for each command is listed after the command name.  

Circle Track Command (Section 2.1.1)  

Drag from  

 center to circle tangent point (Edge) - Ctrl+0  
 circle tangent point (Edge) to center - Ctrl+9  

Position fixed radius circle - Ctrl+8  

Connect Command (Section 2.2.3) - Ctrl+Shift+J  

Remove adjustments starting from an unconnected endpoint - Shift+Left-Click  

Select endpoints to connect - Left-Click  

Curved Track Commands (Section 2.1.2)  

Drag from 1st endpoint  
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 in curve direction - Ctrl+4  
 to Center - Ctrl+5  
 to 2nd endpoint (Chord) - Ctrl+7  

Drag from Center to 1st endpoint - Ctrl+6  

Properties Command (Section 2.2.11) - Ctrl+?  

Display property sheet for the object - Left-Click  

Elevation Command (Section 2.2.4) - Ctrl+Shift+E  

Choose endpoint - Left-Click  

Move Elevation Marker - Right+Drag  

Split track and choose endpoint - Shift+Left-Click  

Flip Command (Section 2.2.5)  

Draw Mirror line - Left+Drag  

Hand-laid Turnout Command (Section 2.1.3) - Ctrl+Shift+I  

Define  

 frog position and angle - (1st Left+Drag)  
 points position - (2nd Left+Drag)  

Helix Track Command (Section 2.1.4) - Ctrl+Shift+H  

Position Helix - (Left+Drag)  

Join Command (Section 2.2.6) - Ctrl+J  

Join tracks - (Left+Drag)  

Move selected tracks to join with unselected endpoint - Shift+Left-Click  

Modify Command (Section 2.2.7) - Ctrl+M  

Change  

 length or make tangent to curve - Left+Drag  
 radius - Shift+Left+Drag  

Extend track - Right+Drag  

Move Command (Section 2.2.8) - Ctrl+Shift+M  

Command Options: how to draw moving objects (Section 3.4) - Shift+Right-Click  
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Move Selected objects - Left+Drag  

Move Description Command (Section 2.2.9) - Ctrl+Shift+Z  

Move Description - Left+Drag  

Toggle Label display for Curved, Helix and Turnout tracks (Section 3.4). - Shift+Right-Click  

Note Command (Section 2.3.3) - Ctrl+Alt+N  

Position Note - Left+Drag  

Parallel Command (Section 2.1.5) - Ctrl+Shift+P  

Position Parallel track relative to selected track - (Left+Drag)  

Print Command (Section 2.5.6) - Ctrl+P  

Command Options: rotate by specified amount (Section 3.4) - (Shift+Right-Click)  

Move Print grid - Shift+Left+Drag  

Rotate Print grid - Shift+Right+Drag  

Select or unselect pages - Left-Click  

Profile Command (Section 2.2.10) - Ctrl+Shift+F  

Add tracks to path from path end to chosen endpoint - (Left-Click)  

Command Options: change Elevation type - (Shift+Right-Click) (Section 3.4)  

Rotate Command (Section 2.2.13) - Ctrl+Shift+R  

Command Options: how to draw moving objects and rotate by specified amount (Section 3.4) - 

Shift+Right-Click  

Rotate Selected objects - Left+Drag  

 in increments of 15° - Ctrl+Left+Drag  

Ruler Command (Section 2.3.4)  

Position Ruler - Left+Drag  

Select Command (Section 2.2.14) - Ctrl+E  

Command Options: how to draw moving objects and rotate by specified amount (Section 3.4) - 

Shift+Right-Click  
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Move  

 selected objects - Shift+Left+Drag  
 labels - Ctrl+Left+Drag  

Unselect all objects within the highlighted area - Right+Drag  

Rotate selected objects - Shift+Right+Drag  

 in increments of 15° - Ctrl+Shift+Right+Drag  

Select (or unselect) the object - Left-Click  

Select all objects  

 connected to object - Shift+Left+Click  
 within the highlighted area - Left+Drag  

Snap Grid Command (Section 2.12.1) - Ctrl+Alt+G  

Command Options: rotate by specified amount (Section 3.4) - Shift+Right-Click  

Move Snap Grid - Left+Drag  

Rotate Snap Grid - Right+Drag  

Split Track Command (Section 2.2.15) - Ctrl+Shift+S  

As above, plus trim turnouts - Shift+Left-Click  

Change block gaps (Section 3.4) - Shift+Right-Click  

If at endpoint: disconnect track, otherwise: split track - Left-Click  

Straight Track Command (Section 2.1.6) - Ctrl+G  

Place 1st and 2nd endpoints - Left+Drag  

Structure Command (Section 2.1.7) - Ctrl+Shift+C  

Command Options: rotate by specified amount (Section 3.4) - Shift+Right-Click  

Place Structure - Left+Drag  

Rotate - Right+Drag  

Text Command (Section 2.3.7) - Ctrl+Shift+X  

Command Options: change Font (Section 3.4) - Shift+Right-Click  

Position text - Left+Drag  
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Train Simulation Command (Section 2.9.7)  

Command Options: uncouple car, flip or remove cars or Trains, set MU Master - Right-Click  

Move a Car or Train - Left+Drag  

Switch a Turnout or rotate a Turntable - Shift+Left-Click  

Turntable Command (Section 2.1.9) - Ctrl+Shift+N  

Position Turntable - Left+Drag  

Turnout Command (Section 2.1.8) - Ctrl+T  

Choose next Active endpoint when placing Turnouts - Shift+Left-Click  

Command Options: rotate by specified amount (Section 3.4) - Shift+Right-Click  

Place Turnout - Left+Drag  

Rotate - Right+Drag  

Suppress auto-adjustment positioning when placing Turnouts - Shift+Left+Drag  
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Appendix A: Frequently Asked Questions 

A.1 Moving from Design to Roadbed  

Your design is complete and your now ready to lay track. How do you go from the computer 

screen to the roadbed?  

The best way to move your design from computer to roadbed is to print out a full scale copy (or 

portions) of the layout. During the print process the orientation of the print grid can be adjusted so the 

printout will line up with the tracks.  

If you have cut-sheet printer (like a laser or ink-jet) set the Ignore Page Margins toggle on the print 

dialog. Normally there is an unprintable margin around the edge of the page and XTrackCAD only 

prints on the printable area, which means you would have to trim or overlay the pages. Setting the 

Ignore Page Margins toggle makes XTrackCAD ignore this margin so you can just abut the paper. 

Also, turn on Print Roadbed Outline and set your roadbed width.  

If you have a continuous form printer (like a dot matrix) you can print a series of pages to form a 

continuous strip as long as you need. I use an old wide carriage printer that was being thrown out and 

can print 8' by 13.2" strips. Accuracy is not critical, 9-pin will do fine. You may need to experiment 

with setting the Landscape/Portrait modes on the Printer Setup and the Print dialogs and rotating the 

Print Grid to get the pages in the correct orientation. In particular I've found it best to set the Printer 

Setup dialog to Portrait mode and select Landscape Page Format on the XTrackCAD Printer dialog.  

Once you have a full scale print-out of your layout (or portion, if you have a larger layout you don't 

want to do it all at once) you need to transfer this to the roadbed. Here's two methods that can be used:  

 Use a spray adhesive (such as 3M Super 77) to glue the print-out to the roadbed. This is very 

messy, takes more glue than expected and is very unforgiving of mistakes. You may want to 

use this method only for small sections of very complicated track-work.  

 Tape the print-out to the roadbed then using a tracing wheel (available at Sewing shops), trace 

the center-line of the track and roadbed outline. At this point consider places when you'll want 

to widen the roadbed to support signals, switch machines, joints etc.  

 

 

 

 



A.2 Hot Bar Items Missing! 

After installing XTrackCAD the Hot Bar is not active; the arrows to the left and the right of the 

Hot Bar are a grey colour instead of black, the Hot Bar is blank and also does not scroll.  

There's nothing wrong, you just need to load a track or structure Parameter file. Open the Parameter 

dialog window (File>Parameter) then click on Browse. A list of *.xtp files with names like 

atlasn55.xtp should appear. Select whichever file or files are appropriate for your needs then click 

the OK button. Click OK on the Parameter File dialog and you should now have objects displayed on 

the Hot Bar.  

Notes:  

1. Only elements that fit the selected scale are available in the Hot Bar. Thus if you're sure the 

parameter file has been loaded via the File>Parameter dialog, make sure the correct scale has 

been selected for the layout (Options>Layout).  

2. If a long list of parameter files is selected, movement within the Hot Bar can be slow. If you 

right-click on the Hot Bar, a list of available parameter sets is shown. By Left-Clicking the 

desired parameter set, the Hot Bar is immediately scrolled to the first element in that parameter 

set.  

3. When a new layout is created or when XTrackCAD is started for the first time, the scale of the 

layout defaults to N scale. Do not forget to change the scale in order to see tracks from other 

scales in the Hot Bar!  

 

 

 

 

 

 

 

 



A.3 Unable to Add Cars to Inventory! 

After installing XTrackCAD you're unable to add cars to the Car Inventory list; a message 

stating "No Car Prototypes are defined...." appears when you attempt to add cars to the Car 

Inventory list.  

There's nothing wrong, you just need to load a Prototype definition file.  

XTrackCAD includes a parameter file which defines many common North American Prototypes. The 

file is named protoam.xtp. It's loaded into XTrackCAD in the same way that a track, structure or car 

Parameter file would be loaded.  

 Open the Parameter dialog window (File>Parameter) then click on Browse. Scroll through the list of 
*.xtp files to locate the file named protoam.xtp. Select this file then click the OK button. Click OK 
on the Parameter File dialog to complete installation of the prototype file. You should now be able to 
add cars to the Car Inventory list.  

Other prototype definitions can be created using the Car Prototype dialog. Refer to Section 2.9.1.3 for 

detail.  
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A.4 Button Bar Icons Missing or Obscure 

Why are Button Bar icons missing or obscure?  

On systems restricted to 256 colors, it's not possible to display all colors on button faces. In this case, 

Windows chooses the closest matching color, which may be the same as the buttons background color. 

When this occurs the Button Bar icon may be obscured or appear to be missing.  

In cases where Layer Buttons are affected the number on the button may not be visible. Although it 

may not be possible to view the layer number, the correct color will be used to color objects that 

appear on the layer.  

 

 

 

 

 

 

 

 

 

 

 

 



A.5 How Do I Place and Join Tracks 

How do I join tracks, place turnouts, build a yard etc?  

First take a look at the help file. Then try the demos (Help>Demos menu). This should answer a lot of 

questions on how to use XTrackCAD. Please visit The XTrackCAD Wiki if you need help, especially 

if you find the documentation unclear or think some area needs improvement.  
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Appendix B: Glossary 

This section contains a helpful listing of Window and XTrackCAD terminology.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



B.1 Window Terms 

Menu and sub-menu items are indicated by File>Open, which means select the File menu and then 

select the Open menu item.  

Balloon Help - short help message which is displayed as you move the mouse pointer over a control.  

Canvas - an area within a window where objects are drawn.  

Check Box - a button with a small square indicator to the left of its text. A check mark appears in the 

indicator when the button is selected.  

Click - press and then release the left mouse button.  

Drag - press and hold down the left mouse button and move the mouse to 'drag' the cursor on the 

screen.  

Dialog - a type of window in which you input information.  

Drop Down List - a list-box which is only displayed when you click on the 'drop-down' button.  

Edit Box - an area where you can enter a String, Integer or Floating Point value.  

Highlighted - an area on the Canvas which is in inverse-video.  

Left-Click - same as Click, used in contexts where Right-Click is also used.  

Left+Drag - same as Drag, used in contexts where Right+Drag is also used.  

Mouse Pointer - is most often an arrow that is you can use to point at different objects on your screen. 

When the pointer is over an object, you can Click a mouse button to perform an action on that object 

(such as selecting the object).  

Press - click on a button.  

Radio Button - a button with a small round indicator to the left of its text. The indicator is filled when 

the button is selected.  

Radio Button Group - a group of radio buttons which indicate mutually exclusive choices.  

Resizing Border - a thick border around re-sizable windows that you can use to change the window 

size.  

Right-Click - press and then release the right mouse button.  



Right Drag - press and hold down the right mouse button and move the mouse to 'drag' the cursor on 

the screen.  

Select - click on an object to indicate you want to do something with it.  

Shift+Left-Click - Left-Click while holding down the Shift key.  

Shift+Right-Click - Right-Click while holding down the Shift key.  

 

 

 

 

 

 

 

 

 

 

 

 

 



B.2 XTrackCAD Terms 

Active Endpoint - when placing a turnout, the endpoint which is used as a 'handle' when moved along 

other tracks.  

Auto-connect - when placing turnouts (Section 2.7) and creating parallel (Section 2.1.5) tracks, the 

new track will automatically be connected to other tracks if the tracks are aligned properly.  

Block Gap - provides control by dividing the layout into electrically isolated blocks, where trains can 

be slowed or stopped by lowering or cutting the power to a block. Dividing a layout into blocks also 

permits operators to run more than one train on a layout with much less risk of a fast train catching up 

with and hitting a slow train. Blocks can also trigger signals or other animated accessories on the 

layout, adding more realism (or whimsy) to the layout. Three-rail systems will often insulate one of 

the common rails on a section of track, and use a passing train to complete the circuit and activate an 

accessory.  

DXF Format - Abbreviation of Data Exchange File, a two-dimensional graphics file format supported 

by virtually all PC-based CAD products. It was created by AutoDesk for the AutoCAD system.  

Easement - special sections of gradually curving track used to connect straight and curved tracks (or 

two curved tracks). Easements reduce the effects of sudden changes in track curves which can cause 

derailments. They also look great!  

Endpoint - One of the most important concepts in XTrackCAD is the endpoint. A piece of flex-track 

has an endpoint at each end. An endpoint has a position and an angle and it can be connected to other 

endpoints. The endpoints control where the track is placed and how it is connected.  

 Turnouts have several endpoints (normally 3).  

 Turntables have a varying number.  

Error Message - an error message displayed in the Status Bar (Section 3.1) accompanied by a beep.  

Flex-track - Prefabricated flexible sections of track used on a layout. It usually comes in straight, 

three-foot-long sections which can be bent or shaped as needed. This term is also used for hand-laid 

track.  

Frog - the place on a turnout track where one rail crosses the other.  

Gauge - The distance between the inside of the heads of track rails. Most real railroads in North 

America and Europe are built to a standard gauge of 4'-8 1/2". Narrow gauge means rails with a width 

less than standard gauge. For example, On3 means O scale trains with three scale feet between the 

rails.  

Handlaid - Track that's built with handmade ties, rail, and spikes.  
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Helix - A rising curve which turns around an axis like a corkscrew. Used on multilevel layouts to 

allow trains to go from one level to another.  

Info Message - an informational message displayed in the Status Bar (Section 3.1).  

Object - an item on the layout, such as a track segment, table edge, line, note or text.  

Points - the part of the Turnout that moves to select a path.  

Reverse Curve - a piece of track which curves in one direction then changes direction without any 

appreciable length of straight track between the two curves.  

S-Curve - a curve which bends in one direction and then the other, forming an S-like shape.  

Sectional Track - prefabricated track which cannot be bent, split or changed.  

Selected Endpoint - when selecting track for various reasons the selected endpoint is the one closest 

to the selection point.  

Tangent - A line, curve, or surface meeting another line, curve, or surface at a common point.  

Track Segment - any piece of flex-track, turnout or sectional track.  

Turnout - A piece of track that allows a train to go from one track to another. Called a switch on a 

real railroad. Referred to by number. For example, a no. 6 turnout spreads one unit for each six units of 

travel measured from the frog (the point at which two rails join to form a V).  

 In XTrackCAD, Turnouts also include sectional Tracks, crossings and forms of prefabricated (non-flex) 
track.  

Turnout Frog - the place on the turnout track where one rail crosses the other.  

Turnout Number - the ratio of the number of units along the center line of a switch frog traversed for 

each unit the frog spreads to the sides. A No. 4 frog diverges 1 unit for every 4 it moves ahead; a No. 

6, 1 for every 6 units. Although we usually refer to a turnout or switch number, in reality the 

measurement is for the frog.  

Turnout Points - the part of the Turnout that moves to select a path.  

Unconnected Endpoint - an endpoint which is not connected to another.  
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Appendix C: Messages and Explanations 

C.1 Message Types 

XTrackCAD generates three types of messages:  

Notices, which appear in their own window and require you to press a button to make a choice or 

dismiss them.  

Error messages, which appear in the Status-bar (Section 3.1) and are accompanied by a beep.  

Information messages, which appear in the Status-bar (Section 3.1) without a beep.  

Notices and Error messages that might be encounter are listed here with a explanation. The Recent 

Messages menu item on the Help (Section 2.6) menu contains a list of the most recent messages. 

Selecting one of the entries presents information on the particular message.  

The notation abc|xyx indicates the message can appear with either of the values (abc or xyz). Items in 

UPPERCASE indicate numeric (such as lengths) or string (such as filenames) values.  

Section C.2 provides detail explanation of each information or error message.  

 

 

 

 

 

 

 

 

mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/mainW.html#mainW
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/mainW.html#mainW
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/helpM.html#helpM
mk:@MSITStore:C:/Program%20Files%20(x86)/XTrkCAD%204.0.3a/share/xtrkcad/xtrkcad.chm::/messageList.html#messageList


C.2 Message Explanations 

C.2.1 A Helix must have one or more loops of 

track. 

A Helix cannot be created with less than one complete loop of track. Anything less than one loop is 

considered a section of curved track.  

 

C.2.2 A frozen layer contains selected... 

This operation cannot be executed as segments of Selected track are present on a frozen layer. Track 

changes or deletions may be performed only on unfrozen layers. Deselect objects that appear on frozen 

layers or unfreeze the layers.  

Refer to section 2.9.4 for detail.  

 

C.2.3 A large font has been selected.... 

A large font has been selected. Large fonts (or changing fonts sizes) may take a noticeable amount of 

time to load.  

Refer to section 2.3.7 for detail.  

 

C.2.4 All description fields present in the 

Turnout... 

Turnout descriptions should be as accurate as possible. All description fields listed in the Turnout 

Designer must contain appropriate information.  

Refer to section 2.9.8 for detail.  
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C.2.5 All fields listed in the Group dialog must 

contain data.... 

The Group dialog shows the Manufacturer, Description and part number (Title) of the new definition. 

Initial values are based on selected turnouts and structures or on the last Ungrouped object. The dialog 

also contains a toggle button (Replace with new group?), which is used if you want to replace the 

selected objects with the new definition. All fields listed in this dialog window must contain data.  

Refer to section 2.9.3 for detail.  
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Appendix D: Upgrade From Earlier 

XTrackCAD Version 

This section contains helpful information regarding program changes and the effects such may have 

with respect to layout files made with previous versions of XTrackCAD.  

 

D.1 Version 2.x 

Updated Titles  

 

Version 2.0.0 of XTrkCad introduced a change in the way Turnouts and Structures are named. The 

new method splits the title into 3 parts: Manufacturer, Description and Part Number.  

To help you when upgrading to the new version, when loading an old XTrkCad layout file, 

XTrackCAD detects if the layout uses Turnouts and Structures that have titles in the old format. If so 

this dialog is displayed which allows you to change the titles in your layout to the new format.  

The title of each different type of Turnout is collected and presented in this dialog. Simply select the 

Turnout on the list that matches the one displayed and click 'Update'. Repeat for each type of Turnout 

in your layout.  



If there is no matching Turnout, click on Ignore. The Turnout will retain the old name as the 

Description, with a blank Manufacturer and Part Number.  

Click Cancel to continue loading the file without updating the titles.  

If you Save your file without updating all the titles you will not be able to update the titles later.  

If you are looking at old files without making changes then Click on Cancel to load the file without 

Updates.  

Not updating the titles prevents the customization of the way titles are presented in various lists and on 

the layout. Basic operation of XTrackCAD is not affected.  

 

 

 

 

 

 

 

 

 

 

 

 



D.2 Version 4.0.x 

Check-point Files  

Version 4 of XTrkCad introduces a new way of handling check-point files. This will allow resuming 

your work after a system crash much easier than before.  

If you start XTrkCad V.4.0.x the first time after an upgrade from a earlier version, a pop-up with the 

question: "Program was not terminated properly. Do you want to resume working on the previous 

track plan?"  

Select "Ignore" only if you're sure that the work from your last session has been correctly saved. If 

uncertain or restarting after an earlier failure select "Resume".  

Help System  

The built in help system has been converted to a much more flexible and widely used HTML format. 

With many new graphics and extensively rewritten text the help information is now up-to-date with 

recent development.  

Layer Colour Settings  

Your personal layer color settings are now stored in your preferences. This allows you to apply the 

same settings to other layouts you design.  

Parameter Files Updated  

Thanks to Ralph Boyd, Dwayne Ward, Casey Sterbenz and others, many new and updated parameter 

files were added to this release.  

Wheel mouse  

The wheel on a wheel mouse can now be used to zoom in and out on a layout design.  

 

 

 

 



D.3 Version 4.0.3 

Internationalization  

Internationalization or the ability to localize XTrackCAD for use with various languages was adopted 

during this version upgrade. XTrackCAD is now available with balloon help and daily tips written in 

US English, Finnish and German. The XTrackCAD development team welcomes anyone who wishes 

to volunteer with translation of various support files. Let them know by submitting an offer to assist to 

the XTrackCAD Feature Tracker located at the XTrackCAD Fork Project Site or the XTrackCAD 

Wikka Wish List located at the XTrackCAD Wiki: WishList.  

Minor Fixes and Enhancements  

 Thanks to Martin Fischer, the Button Bar has a much cleaner and sharper look.  

 Several selections within various Option Menus (Layout, Display, Command and Preferences) have 
been re-arranged. In some case the order or grouping of menu items changed. In other cases menu 
items were move to a different menu; still within the sub-set of Option Menus. Our hope is that we've 
made it easier to locate parameter settings that in past were difficult to locate.  

 An new option that allows XTrackCAD to automatically re-open the last layout file has been added to 
the Options>Preferences menu. For detail refer to the ‘On Program Startup’ item found in Section 
2.10.7.  

 Significant updates were made to the Atlas N and HO scale parameter files. Diesel engine and freight 
car information is now contained in four separate parameter files; Atlas HO Scale Cars (atlascho.xtp), 
Atlas HO Scale Diesel Engines (atlaseho.xtp), Atlas N Scale Cars (atlascn.xtp) and Atlas N Scale Diesel 
Engines (atlasen.xtp).  

 Twenty-one prototypes were added to the American Prototype parameter file (protoam.xtp). The 
additional prototypes are;  

o Diesel Engines  
 Dash 8-32BWH, Dash 8-40B, Dash 8-40BW, Dash 8-40C  
 FP7A  
 H15-44, H16-44, H15/16-44  
 RS4/5  
 RSD12  
 S1, S2, S3, S4  
 SD35, SDP35  

o Freight Cars  
 Caboose, NE-6  
 Flat, 42'  
 Tank, 55' and Tank, 65'  
 Reefer, 36'  

http://sourceforge.net/tracker/?group_id=151737&atid=781981
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 XTrackCAD users reported difficulty when attempting to activate grid lines in version 4.02. The 
problem was noticeable only on new installations. A default grid size of zero was found to be the 
cause of the problem. The default grid size has been changed to 1 thus eliminating the problem.  

 A small bug preventing Zooms of less than 1:1 (Refer to Section 2.12.3 for detail.) was accidentally 
introduced in version 4.0.1. This problem has been corrected in version 4.0.3.  

 When new scale definitions were added to XTrkCad 4.0.2, a small bug broke the file format for some 
scales (eg., N UK). This problem has been corrected in version 4.0.3.  

 Some users of the Linux based application reported the Sticky Commands menu would exceed screen 
length. Spacing between Sticky Commands options has been improved in order to prevent this 
problem.  

 We've no idea when certain demo's broke however thanks to the work of Mikko Nissinen, many 
broken demos are now fixed.  

Name Change  

With release of this version of XTrackCAD there's been a subtle change in the spelling and punctuation 

of the applications name. From this version forward, the application will be know as XTrackCAD. 

Please note the spelling and capitalization of the name.  

Why was the name changed? This release gives XTrackCAD developers an opportunity to included a 

much sought after feature; Internationalization (Through i18n). On the surface this doesn't sound that 

big however having the ability to internationalize or localize the product has great advantages for all 

users. Not only is there great potential for the application to become available to a larger audience, our 

hope it that the developer pool will expand which should result in more features being added to the 

application.  
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Appendix E: Warranty, License and Copying 

XTrackCAD is Copyright 2003, Sillub Technology and Copyright 2007, Bob Blackwell and Martin 

Fischer.  

Some icons are taken from the Tango Free Desktop project and are covered by the Creative Commons 

Attribution-ShareAlike 2.5 License Agreement.  

 

 

 

 

 

 

 

 

 

 

 

 

 

http://tango.freedesktop.org/


E.1 Warranty 

XTrackCAD is provided "as is" without warranty of any kind, either express or implied, including, but 

not limited to warranties of merchantability or fitness for a particular purpose. In no event will Sillub 

Technology be liable for any damages, including incidental or consequential damages, arising out of 

the use of the program, even if advised of the possibility of such damages.  

 

 

 

 

 

 

 

 

 

 

 

 

 



E.2 Copying and Distribution 

XTrackCAD is a powerful CAD program for designing Model Railroad layouts.  

XTrackCAD is Copyright 2003, Sillub Technology and Copyright 2007, Bob Blackwell and Martin 

Fischer and licensed as free software; you can redistribute it and/or modify it under the terms of the 

GNU General Public License as published by the Free Software Foundation; either version 2 of the 

License, or (at your option) any later version.  

You should have received a copy of the GNU General Public License along with this program; see the 

file named COPYING or refer to Section E.3. If not, write to the Free Software Foundation, Inc., 59 

Temple Place, Suite 330, Boston, MA 02111-1307 USA  

XTrackCAD Fork is a project for further development of the original XTrackCAD software. Refer to 

the project homepage at http://www.xtrkcad.org/ for news and current releases.  
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E.3 GNU General Public License 

GNU GENERAL PUBLIC LICENSE  

Version 2, June 1991  

Copyright (C) 1989, 1991 Free Software Foundation, Inc.  

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA  

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it 

is not allowed.  

Preamble  

The licenses for most software are designed to take away your freedom to share and change it. By 

contrast, the GNU General Public License is intended to guarantee your freedom to share and change 

free software--to make sure the software is free for all its users. This General Public License applies to 

most of the Free Software Foundation's software and to any other program whose authors commit to 

using it. (Some other Free Software Foundation software is covered by the GNU Library General 

Public License instead.) You can apply it to your programs, too.  

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses 

are designed to make sure that you have the freedom to distribute copies of free software (and charge 

for this service if you wish), that you receive source code or can get it if you want it, that you can 

change the software or use pieces of it in new free programs; and that you know you can do these 

things.  

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to 

ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you 

distribute copies of the software, or if you modify it.  

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the 

recipients all the rights that you have. You must make sure that they, too, receive or can get the source 

code. And you must show them these terms so they know their rights.  

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which 

gives you legal permission to copy, distribute and/or modify the software.  

Also, for each author's protection and ours, we want to make certain that everyone understands that 

there is no warranty for this free software. If the software is modified by someone else and passed on, 

we want its recipients to know that what they have is not the original, so that any problems introduced 

by others will not reflect on the original authors' reputations.  

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger 

that redistributors of a free program will individually obtain patent licenses, in effect making the 

program proprietary. To prevent this, we have made it clear that any patent must be licensed for 

everyone's free use or not licensed at all.  



The precise terms and conditions for copying, distribution and modification follow.  

GNU GENERAL PUBLIC LICENSE  

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION  

0. This License applies to any program or other work which contains a notice placed by the copyright 

holder saying it may be distributed under the terms of this General Public License. The "Program", 

below, refers to any such program or work, and a "work based on the Program" means either the 

Program or any derivative work under copyright law: that is to say, a work containing the Program or 

a portion of it, either verbatim or with modifications and/or translated into another language. 

(Hereinafter, translation is included without limitation in the term "modification".) Each licensee is 

addressed as "you".  

Activities other than copying, distribution and modification are not covered by this License; they are 

outside its scope. The act of running the Program is not restricted, and the output from the Program is 

covered only if its contents constitute a work based on the Program (independent of having been made 

by running the Program). Whether that is true depends on what the Program does.  

1. You may copy and distribute verbatim copies of the Program's source code as you receive it, in any 

medium, provided that you conspicuously and appropriately publish on each copy an appropriate 

copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to 

the absence of any warranty; and give any other recipients of the Program a copy of this License along 

with the Program.  

You may charge a fee for the physical act of transferring a copy, and you may at your option offer 

warranty protection in exchange for a fee.  

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based 

on the Program, and copy and distribute such modifications or work under the terms of Section 1 

above, provided that you also meet all of these conditions:  

a) You must cause the modified files to carry prominent notices stating that you changed the 

files and the date of any change.  

b) You must cause any work that you distribute or publish, that in whole or in part contains or 

is derived from the Program or any part thereof, to be licensed as a whole at no charge to all 

third parties under the terms of this License.  

c) If the modified program normally reads commands interactively when run, you must cause 

it, when started running for such interactive use in the most ordinary way, to print or display an 

announcement including an appropriate copyright notice and a notice that there is no warranty 

(or else, saying that you provide a warranty) and that users may redistribute the program under 

these conditions, and telling the user how to view a copy of this License. (Exception: if the 

Program itself is interactive but does not normally print such an announcement, your work 

based on the Program is not required to print an announcement.)  

These requirements apply to the modified work as a whole. If identifiable sections of that work are not 

derived from the Program, and can be reasonably considered independent and separate works in 



themselves, then this License, and its terms, do not apply to those sections when you distribute them as 

separate works. But when you distribute the same sections as part of a whole which is a work based on 

the Program, the distribution of the whole must be on the terms of this License, whose permissions for 

other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.  

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by 

you; rather, the intent is to exercise the right to control the distribution of derivative or collective 

works based on the Program.  

In addition, mere aggregation of another work not based on the Program with the Program (or with a 

work based on the Program) on a volume of a storage or distribution medium does not bring the other 

work under the scope of this License.  

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or 

executable form under the terms of Sections 1 and 2 above provided that you also do one of the 

following:  

a) Accompany it with the complete corresponding machine-readable source code, which must 

be distributed under the terms of Sections 1 and 2 above on a medium customarily used for 

software interchange; or,  

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a 

charge no more than your cost of physically performing source distribution, a complete 

machine-readable copy of the corresponding source code, to be distributed under the terms of 

Sections 1 and 2 above on a medium customarily used for software interchange; or,  

c) Accompany it with the information you received as to the offer to distribute corresponding 

source code. (This alternative is allowed only for noncommercial distribution and only if you 

received the program in object code or executable form with such an offer, in accord with 

Subsection b above.)  

The source code for a work means the preferred form of the work for making modifications to it. For 

an executable work, complete source code means all the source code for all modules it contains, plus 

any associated interface definition files, plus the scripts used to control compilation and installation of 

the executable. However, as a special exception, the source code distributed need not include anything 

that is normally distributed (in either source or binary form) with the major components (compiler, 

kernel, and so on) of the operating system on which the executable runs, unless that component itself 

accompanies the executable.  

If distribution of executable or object code is made by offering access to copy from a designated place, 

then offering equivalent access to copy the source code from the same place counts as distribution of 

the source code, even though third parties are not compelled to copy the source along with the object 

code.  

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided 

under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is 

void, and will automatically terminate your rights under this License. However, parties who have 

received copies, or rights, from you under this License will not have their licenses terminated so long 

as such parties remain in full compliance.  



5. You are not required to accept this License, since you have not signed it. However, nothing else 

grants you permission to modify or distribute the Program or its derivative works. These actions are 

prohibited by law if you do not accept this License. Therefore, by modifying or distributing the 

Program (or any work based on the Program), you indicate your acceptance of this License to do so, 

and all its terms and conditions for copying, distributing or modifying the Program or works based on 

it.  

6. Each time you redistribute the Program (or any work based on the Program), the recipient 

automatically receives a license from the original licensor to copy, distribute or modify the Program 

subject to these terms and conditions. You may not impose any further restrictions on the recipients' 

exercise of the rights granted herein. You are not responsible for enforcing compliance by third parties 

to this License.  

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason 

(not limited to patent issues), conditions are imposed on you (whether by court order, agreement or 

otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of 

this License. If you cannot distribute so as to satisfy simultaneously your obligations under this 

License and any other pertinent obligations, then as a consequence you may not distribute the Program 

at all. For example, if a patent license would not permit royalty-free redistribution of the Program by 

all those who receive copies directly or indirectly through you, then the only way you could satisfy 

both it and this License would be to refrain entirely from distribution of the Program.  

If any portion of this section is held invalid or unenforceable under any particular circumstance, the 

balance of the section is intended to apply and the section as a whole is intended to apply in other 

circumstances.  

It is not the purpose of this section to induce you to infringe any patents or other property right claims 

or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of 

the free software distribution system, which is implemented by public license practices. Many people 

have made generous contributions to the wide range of software distributed through that system in 

reliance on consistent application of that system; it is up to the author/donor to decide if he or she is 

willing to distribute software through any other system and a licensee cannot impose that choice.  

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of 

this License.  

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by 

copyrighted interfaces, the original copyright holder who places the Program under this License may 

add an explicit geographical distribution limitation excluding those countries, so that distribution is 

permitted only in or among countries not thus excluded. In such case, this License incorporates the 

limitation as if written in the body of this License.  

9. The Free Software Foundation may publish revised and/or new versions of the General Public 

License from time to time. Such new versions will be similar in spirit to the present version, but may 

differ in detail to address new problems or concerns.  



Each version is given a distinguishing version number. If the Program specifies a version number of 

this License which applies to it and "any later version", you have the option of following the terms and 

conditions either of that version or of any later version published by the Free Software Foundation. If 

the Program does not specify a version number of this License, you may choose any version ever 

published by the Free Software Foundation.  

10. If you wish to incorporate parts of the Program into other free programs whose distribution 

conditions are different, write to the author to ask for permission. For software which is copyrighted 

by the Free Software Foundation, write to the Free Software Foundation; we sometimes make 

exceptions for this. Our decision will be guided by the two goals of preserving the free status of all 

derivatives of our free software and of promoting the sharing and reuse of software generally.  

NO WARRANTY  

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY 

FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT 

WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER 

PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 

EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH 

YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL 

NECESSARY SERVICING, REPAIR OR CORRECTION.  

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 

WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 

REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR 

DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 

DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM 

(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED 

INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 

THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER 

OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

END OF TERMS AND CONDITIONS  

 

 


